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Notations and Conventions
Symbol Usage

This guide uses the following symbols.

Information essential to operations, such as explanations of
functions or terminology, follows this symbol.

Information about the steps to perform follows this symbol.

Operating tips and convenient ways of using the program
follow this symbol. Read these topics as you see fit.

IMPORTANT

Points that you need to follow to perform the procedures and
other important topics follow this symbol. Always read these
topics.

REFERENCE

Supplementary explanations and procedures follow this symbol.
Read these topics as you see fit.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

NOTE

• This manual uses Windows XP screen shots and procedures in
the explanations. The screen shots and procedures may appear
slightly different if you are using another version of Windows.

• The displayed screens and procedures may also differ slightly
from the examples depending upon the camera or printer model
in use.



Table of
Contents

Chapter 1
What is

ZoomBrowser EX?

Chapter 2
Downloading and

Printing Images

Chapter 3
What You Can Do with
a Camera Connected

Chapter 4
Viewing Images

Chapter 5
Organizing Images

Chapter 6
Using Supplementary

Features
Appendices Index

ZoomBrowser EX Software User Guide 5 Back Next

This section provides a brief explanation of the ZoomBrowser EX
features.

What You Can Do with a Camera Connected

• Download images from the camera to the computer.
• Download sound files that you record using the Sound

Recorder feature (only on products supporting the Sound
Recorder feature).

• Save computer images to the camera.
• Select images directly in the camera or memory card and

print them.
• Operate the camera shutter remotely from the computer

(only on models supporting remote shooting).
• Check and change camera settings.
• Set the My Camera Settings (start-up image, start-up sound,

operation sound, self-timer sound and shutter sound). (Only
on models supporting My Camera Settings)

View Images

• Display the downloaded images and their shooting
information.

• Switch between display modes (zoom, scroll and preview).

Organize Images

• Assign a Star Rating or keywords to images.
• Organize images according to their shooting dates.
• Perform image searches.

Use Additional Features

• Print images that have been downloaded to a computer.
• Edit images and movies.
• Stitch panoramas together.
• Convert RAW images to standard images  (only available on

some models).
• Extract stills from movies (Windows XP only).
• Format images as screensaver and wallpaper files.
• Export image shooting information as a text file.
• Copy images to CD-R/RW disks (Windows XP only).
• Create images and sound files as My Camera Settings files

using the My Camera function (Windows XP and Windows
2000 only).

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• The Canon CD-ROM supplied with the camera contains My
Camera Settings files. These files are automatically copied to
your computer when ZoomBrowser EX is installed.

What Can ZoomBrowser EX Do?
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Guide to the ZoomBrowser EX Windows (1/2)
This section briefly introduces the purposes and features of the two
main windows for operating ZoomBrowser EX.

Camera Control Window

The Camera Control Window is the window that automatically
opens when you connect a camera to the computer or insert a
memory card into a memory card reader. You can download
the camera or memory card images in a few easy steps. You
can also select and print camera or memory card images
directly and change camera settings from the computer.

Main Window

This window opens when you start ZoomBrowser EX. The Main
Window is for displaying and organizing downloaded images.

The window that appears for a wireless connection may differ
slightly.

Folder Area

Task Area

Browser Area
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Using the Right-Click in Operations

With ZoomBrowser EX you can access many useful functions by
using the right mouse button (right-click).

For example, you can position the mouse pointer over an image
in the Browser Area and right-click to display a menu like the
following.

A shortcut menu is a convenient collection of the most
common window buttons and menu commands that apply to a
given situation.

The right-click allows you to use ZoomBrowser EX more
efficiently. After you become familiar with ZoomBrowser EX, try
right-clicking in many situations.

Right-click anywhere on the image to display a shortcut menu.

Browser Area

Guide to the ZoomBrowser EX Windows (2/2)
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Task Area and Task Buttons

There are six task buttons in the Main Window’s Task Area. Use
these buttons to start performing tasks.

■ Acquire & Camera Settings
The Camera Control Window will open.
Connect the camera to the computer with the interface cable
and use the window to download the camera images to the
computer and print them.

■ View & Classify
Use this button to display slide shows of Browser Area images,
classify images into folders and perform image searches.

■ Edit
Use this button to edit images and movies, stitch panoramas
together and convert RAW images.

■ Export
Use this button for such tasks as exporting images and image
information, extracting multiple images from movies and
backing up images to a CD.

■ Print
Use this button to print images that have been downloaded to
a computer.

■ Internet
Use this button to attach and send images as email messages
and to upload images.

The following menus appear when you click each respective
task button.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• To switch between tasks, click the corresponding task button.
• A scroll button will appear at the right when there are too many

menu items to display at once in the Task Area.

Task Buttons and Main Window Features (1/4)
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Task Buttons and Main Window Features (2/4)

Using the Task Windows

When you select an item in the menu, the related steps appear
in the Task Area.

■ Orange Button
This color marks the current step. Follow the instructions in the
right-hand side of the window to proceed. Once you finish a
procedure, click a different button to proceed to the next step.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• In general, you are recommended to proceed through the steps
in order. You can return to the previous step by clicking the
button for that step.
In addition, you can also advance to the next or previous step by
clicking the [Previous] or [Next] buttons at the window’s bottom
right. (These buttons may not appear for some tasks.)

• To return to the first menu, click [Return to Main Menu], which
appears below the menu items.

■ Gray Buttons (Black Letters)
This is the step that you can select at the present time. Switch
to it by clicking the button.
However, if you have already finished selecting an image and you
switch to the [2. Printer and Layout Settings] task, you must click
[1. Select Images] again to reselect the image.

■ Grayed Out Buttons (Gray Letters)
Grayed out buttons indicate tasks that are not available at the
time. When you finish the task underway, the buttons will once
again become selectable.
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Task Buttons and Main Window Features (3/4)

Function Buttons

The following buttons are available in the Main Window.

View Image Button
Displays the selected image in a viewer window.

Properties Button
Displays information for the selected image or folder in
the Properties window.

Slide Show Button
Starts a slide show of the selected images.

Search Button
Searches images using criteria such as the Star Rating,
revision date, shooting date, comments or keywords.

Delete Button
Deletes selected images or folders from the computer.

Rotate Button
Rotates the selected image. Choose between 90° Left,
90° Right or 180°.

Display Modes

Use the tabs to switch between Browser Area display modes.

Back Button
Returns to the view of the Browser Area displayed
immediately prior.

Forward Button
Returns to the view of the Browser Area displayed
prior to use of the Back button.

Up Button
Advances to a higher level folder when you have
navigated to a lower level folder.

Advanced Select Menu
Use this menu to select or deselect all of the images in
the Browser Area at once. You can also use it to select
bracketed images (images shot with the camera’s AEB
function).

Display Control Panel

The display control panel offers the following buttons.
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Show Information Menu
Use this to show or hide image information—such as
the file name, shooting date or Star Rating—below
the thumbnail. You can also use it to show/hide the
attribute icons around the folder or thumbnail edges
and the pop-up window.

Selection Tool Button (Operative only in Zoom
Mode)
Restores the mouse pointer to a “pointer” when the
Zoom In or Zoom Out button is being used.

Zoom In Button (Operative only in Zoom Mode)
Zooms in to folders or images in the Browser Area.

Zoom Out Button (Operative only in Zoom Mode)
Zooms out from folders or images in the Browser
Area.

Pan Button (Operative Only in Zoom Mode)
Changes the area displayed when you zoom in on a
folder or image in the Browser Area and drag the
thumbnail list.

Zoom to 100% Button (Operative Only in Zoom
Mode)
Changes the size of the thumbnail list to fit the
window.

Display Size (Operative only in Zoom or Scroll
Mode)
In Zoom mode, it changes the display magnification of
the entire Browser Area.
In Scroll mode, it changes the thumbnail display size.

Filter Tool
Displays only the images meeting the specified criteria.

The task buttons and other function buttons are discussed in
more detail from Chapter 4 onward.

Task Buttons and Main Window Features (4/4)
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Downloading Images to a Computer (1/8)
This chapter explains a sequence of basic procedures in order, such as
downloading images from the camera and printing downloaded
images. This section starts by explaining the procedures for
downloading images from the camera.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• This guide assumes that all the relevant software programs
and drivers have been correctly installed on your computer. If
you have not yet installed them, read the guide supplied with
your product and install them.

Starting Methods for ZoomBrowser EX

There are two ways to start ZoomBrowser EX: “Connecting the
Camera and Computer” and “Starting ZoomBrowser EX from
the Icon.” The “Connecting the Camera and Computer”
method is generally the most convenient for downloading
images from the camera. Use the icon method under the
following circumstances.

• To use ZoomBrowser EX when a camera or memory card
reader is not connected.

• To restart ZoomBrowser EX with a camera or memory card
reader already attached after the program has been closed.

• To use ZoomBrowser EX when the Auto Start function has
been set to start a different program when the camera is
connected.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• With some versions of Windows, you may not be able to use
the “Connecting the Camera and Computer” method the
very first time the camera is connected after the computer has
been booted up (due to a Windows limitation). Use the icon
method in this case. You can use the “Connecting the
Camera and Computer” method from the second time
onward.
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Connecting the Camera and Computer

This method involves connecting the camera to the computer
and preparing it to exchange data.

1. With the camera attached to the computer, set the
camera to the Playback mode.
See the user guides for your camera for the method for
connecting the camera and computer.

The Camera Control Window will open.
The window that appears for a wireless connection may differ
slightly.

Downloading Images to a Computer (2/8)

Camera Control Window

If you place a check mark here,
this window automatically
opens when the camera is
connected to the computer.

First Time Camera is Connected to a Computer

Configure the following settings the first time you attach the
camera to the computer using an interface cable. This step is
not required from the second connection onward.

When a window similar to the following one (Events
dialog) opens, select [Canon CameraWindow] and
click [OK].

The purpose of these settings is to have ZoomBrowser EX’s
Camera Control Window open automatically when the camera
is connected to the computer.

Your camera model name or
“Canon Camera” will appear
here.

Your computer system
will determine which
programs appear.

If the Events Dialog does not open, see "Troubleshooting" in
the Appendices.
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Downloading Images to a Computer (3/8)

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• If the Scanners and Cameras Wizard displays, close it and use
the icon method to start ZoomBrowser EX.

• When a camera model selection window opens, confirm that
your camera model or [Canon Camera] is selected and click
[OK].

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• With some versions of Windows, you may not be able to use
this method of starting ZoomBrowser EX the very first time
the camera is connected to the computer after it is booted up.
(The Camera Control Window will not display even if you
connect the camera to the computer correctly.)
In this case, use the icon method to start ZoomBrowser EX.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• With a memory card reader, the Events dialog will appear each
time. Select [View/Download Images using Canon
CameraWindow] to open the Camera Control Window.
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This section describes two methods for downloading images shot from
the camera to a computer.

■ Downloading Images with Camera Commands
You can use this method to download images with cameras
that support the direct transfer function.

■ Downloading Images with Computer Commands
This method uses commands entered on the computer to
download images from a memory card in a camera or in a
memory card reader. This method can be used regardless of
whether your camera supports the direct transfer function or not.

Using Camera Commands to Download Images

1. Read the dialog that displays.
Proceed to Step 2 if the Camera Control Window opens on the
computer.
If your camera has a  (Print/Share) button, the  (Print/
Share) button will blink and a Direct Transfer menu, like the one
shown below right, will appear on the camera’s LCD monitor.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• If the Direct Transfer menu does not appear on the camera’s
LCD monitor, you cannot download images using camera
commands.

• The content of the LCD monitor screen and the method for
displaying the Direct Transfer menu may differ between camera
models.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• Check to ensure that the computer and the camera or memory
card reader are in the correct state for communication.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• This section uses the “Download All Camera Images Not Yet
Downloaded” method, a simple method, to download images.
Chapter 3 explains in greater detail how to select images for
downloading from a camera or memory card and how to
perform tasks such as changing the file destination.

• You can also download sound files to the computer that were
recorded using the Sound Recorder feature. The downloading
procedures are explained in Chapter 3 "Downloading Sound
Files from the Camera."

Downloading Images to a Computer (4/8)
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Downloading Images to a Computer (5/8)
○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• When a camera model
selection window opens,
confirm that your camera
model or [Canon Camera] is
selected and click [OK].

2. Use the camera to set the direct transfer settings and
press the  (Print/Share) button or the SET button.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• See the user guides for your camera for explanations of the
settings and commands related to the Direct Transfer menu that
appears on the camera’s LCD monitor.

• You can change the destination folder for images by clicking
[Settings] in the Camera Control Window that appears on the
computer monitor. See “Downloading Images Automatically” in
Chapter 3 for instructions on how to change the destination
folder.

• By the default settings, downloaded images are saved to the My
Pictures folder.

The images will display in the Main Window when the
download is complete. The download mark will display on the
folder(s) in which the images are downloaded.
They will also display in the [Last Acquired Images] area in the
upper part of the Folder Area, arranged according to shooting
dates.

Downloaded ImagesFolders with newly acquired images
display the symbol shown.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can hide the download mark by clearing the check mark for
[Show Download Marks] in the  (Show Information) menu.

Displays newly acquired images.
You can display the images arranged by their shooting
dates. (This is a virtual folder)
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Downloading Images to a Computer (6/8)

Using Computer Commands to Download Images

1. Read the dialog that displays.
If a Camera Control Window similar to the one below appears,
proceed to Step 3.

2. Click [Acquire & Camera Settings] in the Main
Window, followed by [Connect to Camera].

Proceed to Step 2 if ZoomBrowser EX’s Main Window displays.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• If you are using a memory card
reader, a Camera Control
Window similar to the right will
open.

If you are using a memory card reader, check that the card is
correctly inserted in the reader and then click [Acquire &
Camera Settings], followed by [Acquire Images from Memory
Card].

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• When a camera model selection window opens, confirm that
your camera model or [Canon Camera] is selected and click
[OK].
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Downloading Images to a Computer (7/8)
3. Click [Starts to download images].

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• If you click [Preferences], you can change settings such as the
destination folder and type of image to download. The methods
for changing the settings are explained in “Downloading Images
Automatically” in Chapter 3.

• By the default settings, all images that have not yet been
downloaded are saved to the My Pictures folder.

When the download is complete, the downloaded images will
appear in the Main Window. The download mark will display
on the folders in which images are downloaded.
They will also display in the [Last Acquired Images] area in the
upper part of the Folder Area, arranged according to shooting
dates.

Downloaded ImagesFolders with newly acquired images
display the symbol shown.

Displays newly acquired images.
You can display the images arranged by their shooting
dates. (This is a virtual folder)
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Downloading Images to a Computer (8/8)

Starting by Clicking an Icon or Menu

Use the following methods to start ZoomBrowser EX using its
desktop icon or a menu.

■ The Icon Method

1. Double-click the [ZoomBrowser EX] icon on the desktop.

ZoomBrowser EX will start and open its Main Window.

■ The Menu Method

1. Click the [Start] menu and select [All Programs] or
[Programs], followed by [Canon Utilities],
[ZoomBrowser EX] and [ZoomBrowser EX].
ZoomBrowser EX will start and open its Main Window.

The downloading procedures after this are described in
“Downloading Images to a Computer (6/8).”

Closing ZoomBrowser EX

To close ZoomBrowser EX, click  in the Main Window or click
the [File] menu and select [Exit].

Main Window

The downloading procedures after this are described in
“Downloading Images to a Computer (6/8).”
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This section explains how to print images downloaded to a computer. It
describes the procedures for printing a single image on a single page. It
is easy to print photo-quality prints.

2. Confirm that [1. Select Images] is chosen and select
images for printing.
The background of the selected images will change to blue.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can select multiple images by pressing and holding the [Ctrl]
key while you click on successive images. To deselect an image,
hold down the [Ctrl] key and click the image again.

Printing a Single Image on a Single Page (1/2)

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• If you have installed the Easy-PhotoPrint program supplied
with a Canon-brand printer, the Print window of Easy-
PhotoPrint will automatically open if you select [One Photo
per Page Print]. See the Easy-PhotoPrint [Help] menu for
procedural instructions.

• The method for proceeding to the ZoomBrowser EX Print
window when you select [One Photo per Page Print] as shown
in Step 2 is explained in the Appendices in “Customizing
Preferences.”

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• The procedures for printing indexes are explained in Chapter 6,
“Index Print.”

1. Click [Print] in the Main Window, followed by [One
Photo per Page Print].
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3. Click [2. Printer and Layout Settings] and set the
categories as desired.

Sets the borderless printing and auto trim (crops image
edges according to the page proportions) settings.

Printing a Single Image on a Single Page (2/2)
4. Click [3. Print].

Printing will start.

Sets the printer and
paper size settings. Rotates images.

Click this to use the
trimming function (crops a
portion of the image).

Click this button to switch
between images if multiple
images were selected.

Sets the number of print
copies.

Sets the shooting date/time
imprint and color settings.
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Camera Control Window (1/2)
This chapter explains the operations that can be performed with the
Camera Control Window. Opening the Camera Control Window

The Camera Control Window will automatically open when the
camera is connected to your computer.
When the ZoomBrowser EX Main
Window is open, click [Acquire &
Camera Settings] in the Task Area,
followed by any menu item to open
the Camera Control Window.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• If the Camera Control Window does not open, click the [Start]
menu and select [All Programs] or [Programs], followed by
[Canon Utilities], [CameraWindow], [PowerShot - IXY - IXUS -
DV 6] and [CameraWindow].

• If you are using a memory card reader, click the [Start] menu and
select [All Programs] or [Programs], followed by [CanonUtilities],
[CameraWindow], [CameraWindowMC], and [CameraWindow].

This explains the procedures for
downloading camera images using
the camera’s Direct Transfer function.

Selects a function in the
Camera Control Window.

You can download images
in a single pass using a
computer operation.

You can check images first
before downloading using
a computer operation.

If you remove the check mark
from here* , the Events dialog
(p. 13) will appear the next
time the camera is connected
to the computer.

Sets the attributes
and destination for
images targeted
for automatic
downloading.

Closes the Camera
Control Window.*

* This option will "gray out" when you are using a wireless connection.
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Camera Control Window (2/2)

Closing the Camera Control Window

Click [Finish] to close the Camera Control Window.

When you are connected wirelessly, the Camera Control
Window will close when you close the connection. See the user
guides for your camera for information about closing a wireless
connection.
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Starting Auto Downloading

1. Set the Direct Transfer settings on the camera, and
start the direct transfer.
This will download images automatically to the computer.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• See the user guides for your camera for explanations of the
settings and commands related to the Direct Transfer menu that
appears on the camera’s LCD monitor.

• Sound files recorded using the Sound Recorder feature cannot
be downloaded using the Direct Transfer feature. The
downloading procedures are explained in "Downloading Sound
Files from the Camera."

2. Select [Change direct transfer download destination
folder] and click [Next].

3. Select a destination folder for the downloaded
images and set the new folder creation method for
downloads, then click [Next].
Proceed to Step 5 when “Finished” appears.

Changing the Auto Download Settings

Change the destination folder for images downloaded to the
computer.

1. Click [Preferences].

Downloading Images Automatically—Camera Operations (1/2)
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Downloading Images Automatically—Camera Operations (2/2)
4 To connect a camera to a computer over a wireless

connection to use [Print via a Computer], click
[Settings] and configure the printer to be used, as
well as other settings such as the paper size.
Proceed directly to Step 5 if you are not using the [Print via a
Computer] function over a wireless connection.

5 Click [Finish].
The settings window will close.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• See the user guides for your camera for information about the
settings and procedures for the camera's Direct Transfer menu.
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Downloading Images Automatically—Computer Operations (1/3)

Starting Auto Downloading

1. Click [Starts to download images] in the Camera
Control Window.
Under the default settings, all images not yet downloaded will
automatically download to the computer.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• Sound files recorded using the Sound Recorder feature cannot
be downloaded using the Auto Download feature. The
downloading procedures are explained in "Downloading Sound
Files from the Camera."

2. Select [Change auto download settings] and click
[Next].

Changing the Auto Download Settings

Change the type of image to download or the destination
folder.

1. Click [Preferences].
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Downloading Images Automatically—Computer Operations (2/3)

4. Select a destination folder for the downloaded
images and set the new subfolder creation method
for downloads, then click [Next].

5. Set the process to initiate after the images are
downloaded and click [Next].
To simply display the images in ZoomBrowser EX’s Browser
Window, select [Display the folder at the save destination].
To initiate a different process, select [Perform selected processes
consecutively] and select a process in the Select Process
window.

3. Select the type of image to download and click [Next].

Place a check mark here if you wish the original image
in the camera to be deleted after downloading.
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6. To initiate the selected auto download process
immediately after the camera and computer are
connected, place a check mark beside [Images are
automatically downloaded to computer while camera
is connected].
You cannot place a check in this option when using a wireless
connection.

7. Click [Finish].
This concludes the settings procedure.

Downloading Images Automatically—Computer Operations (3/3)
○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• ZoomBrowser EX rotates images to match the camera display
orientation. However, it does not alter the image data itself. If a
rotated image is opened in a program that does not support
rotated display, it will appear in its pre-rotation state. See
“Customizing Preferences” in the Appendices for an explanation
of how to alter the image data with rotation information so it
downloads in the rotated orientation.
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Checking Images in the Camera before Downloading (1/2)

Selecting Images and Initiating the Download

1. Click [Lets you select and download images] in the
Camera Control Window.

2. Select images for downloading in the Camera Browser
Window.
The background color of the selected image will change to
blue. You can select multiple images by pressing and holding
the [Ctrl] key while you click on successive images. You can also
select a series of adjacent images by pressing and holding the
[Shift] key while clicking on the first and last images.

3. Click [Image Download].

The Camera Browser Window will open and display the images
contained in the camera.

A window for setting the destination folder and other settings
will open.

Camera Browser Window
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Checking Images in the Camera before Downloading (2/2)
4. Confirm whether changes are required for the file

destination or name.
To make changes, click [Change Settings].

5. Click [Starts Download].
The images will download to the computer.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can also download sound files to the computer that were
recorded using the Sound Recorder feature. The downloading
procedures are explained in "Downloading Sound Files from the
Camera."

To change the file
name, select the file
prefix format and
the consecutive
numbering system.

Specify a folder as
the destination for
downloaded images.

Click here to change
the destination folder.

Specify whether or not
a subfolder is created
and input a name.
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Deleting Images from the Camera
This section explains how to use the Camera Browser Window to delete
images from the camera.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You cannot delete protected images (images bearing the 
symbol).

1. Click [Lets you select and download images] in the
Camera Control Window.

2. Select images for deleting in the Camera Browser
Window.
The background color of the selected image will change to
blue. You can select multiple images by pressing and holding
the [Ctrl] key while you click on successive images. You can also
select a series of adjacent images by pressing and holding the
[Shift] key while clicking on the first and last images.

3. Click  (Delete Image).

A confirmation dialog will display.

4. Click [Yes].
The image will be deleted.

Camera Browser Window will open.
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Downloading Sound Files from the Camera (1/3)
This topic explains how to download sound files recorded with the
camera's Sound Recorder feature to the computer.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• See the user guides for your camera to find out whether or
not your camera supports the Sound Recorder feature.

• Sound files cannot be deleted using the Camera Browser
Window.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• Sound files recorded with the camera's Sound Recorder feature
differ from the sounds attached to images. They are
independent sound files (WAV type).

Initiating Downloading

1. Click [Lets you select and download images] in the
Camera Control Window.

Camera Browser Window

The Camera Browser Window will open. If sound files are
contained in the camera or memory card, the [Download
Sound] button will display.

2. Click [Download Sound].
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A window for setting the destination folder and other settings
will open.

Downloading Sound Files from the Camera (2/3)
A list of sound files will display.

This symbol appears if the file is protected.

This symbol appears if the file has been
downloaded to the computer previously.

3. Select sound file(s) to download.
The selected files display in blue.
You can select multiple files by pressing and holding the [Ctrl]
key while you click on successive files. You can also select a
series of adjacent files by pressing and holding the [Shift] key
while clicking on the first and last images.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• It is convenient to use the [Select Files] menu to select all the
files, to deselect files, to select protected files or to select files
that have not yet been downloaded.

4. Click [Download Sound].
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Downloading Sound Files from the Camera (3/3)
5. Confirm whether changes are required for the file

destination or name.
To make changes, click [Change Settings].

6. Click [Starts Download].
The file(s) will download to the computer.

To change the file
name, set the text
characters for the
file prefix and the
consecutive
numbering system.

Specify a folder as
the destination for
downloaded files.

Click here to change
the destination folder.

Specify whether or not
a subfolder is created
and input a name.
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Other Features of the Camera Browser Window
This section explains the other features of the Camera Browser
Window. ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can also download images displayed in the Camera Browser
Window by dragging and dropping them into ZoomBrowser
EX’s Browser Area or Folder Area.

Selects the image
selection method.

Changes the size of
the image thumbnail
(tiny version).

Selects whether the image border
and file name are shown or hidden.

Selects whether the image
information at the window’s
bottom right is shown or
hidden.

Starts ZoomBrowser EX.

Image Information
(This will not display if you
are using a memory card
reader.)

Histogram

Prints the
selected images.
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This function allows you to select images directly from the camera or
memory card and print them.

Four Printing Methods

There are four ways to print images from the camera as listed
below.

■ Print All Photos
Prints all images from the camera in the format of one image
per page.

■ Print Contact Sheet with All Photos
Prints all images from the camera in an index format (rows of
images on one page).

■ Print according to DPOF settings
Prints according to the DPOF print settings set using the
camera.

■ Select an image and print
Displays a list of the images from the camera, allowing you to
print them selectively.

Printing Procedures

1. Click the [Print] tab in the Camera Control Window.

Printing Images in the Camera (1/4)
2. Click on one of the four printing methods.

A print settings window corresponding to the selected method
will open. Procedures for the respective print settings windows
are explained from the next page onward.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• If ZoomBrowser EX’s Main Window is open, you can display the
Camera Control Window by clicking [Acquire & Camera
Settings] in the task area, followed by [Connect to Camera]. If
you are using a memory card reader, click [Acquire & Camera
Settings], followed by [Acquire Images from Memory Card].

3. Set the print settings and click [Print].
Printing will start.
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Print All Photos

The following print settings window will open if you selected
[Print All Photos].

Printing Images in the Camera (2/4)

Rotates images.

Sets the printer and
paper size settings.

Sets the auto trim (crops
image edges according to
the page proportions) and
borderless printing settings.

Sets the shooting date/time
imprint and color settings.

Click this to use the trimming
function (crops a portion of the
image).

Sets the number of print copies.

Printing will start when
you click [Print].

Click this button to switch
between images if multiple
images were selected.

Print According to DPOF Settings—Standard

A print settings window similar to the following will open if you
select [Print according to DPOF settings] and the standard
option for DPOF print settings has been set using the camera.
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Printing Images in the Camera (3/4)

Print Contact Sheet with All Photos

A print settings window similar to the following will open if you
select [Print Contact Sheet with All Photos].

Print According to DPOF Settings—Index

A print settings window similar to the following will open if you
select [Print according to DPOF settings] and the index option
for DPOF print settings has been set using the camera.

Rotates images.

Sets the printer and
paper size settings.

Click this to use the trimming
function (crops a portion of the
image).

Printing will start when
you click [Print].

Click this button to switch
between images if multiple
images were selected.

The functions in this area are
available while any one of the images
displayed below is selected.

Sets the number
of print copies.

Sets the number of
rows and columns.

Sets the printing settings
for shooting information,
comments, headers,
footers and page numbers.
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Printing Images in the Camera (4/4)

Select an image and print

The Camera Browser Window will open and display the camera
images in a chart if you select [Select an image and print].

1. Select images for printing from the Camera Browser
Window.
The background color of the selected image will change to
blue.
You can select multiple images by pressing and holding the
[Ctrl] key while you click on successive images. You can also
select a series of adjacent images by pressing and holding the
[Shift] key while clicking on the first and last images.

2. Click [Print] and select [Contact Sheet Print] or [One
Photo Per Page Print] from the menu.

The print settings window will open.
See the previous page for printing an index. See two pages
back for printing one photo per page.
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Setting the My Camera Settings (1/8)
This section explains how to save the “My Camera Settings” on your
computer to the camera or vice versa.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• Please see the user guides for your camera to determine
whether or not it supports the My Camera function.

• To save the My Camera Settings to the camera, ensure that
the software supplied with the camera is installed on the
computer.

What are the My Camera settings?

The start-up image for the camera and sounds such as the
start-up sound, the shutter sound, operating sounds and the
self-timer sound are collectively referred to as the My Camera
Settings. You can add your favorite images and sounds from
your computer to the My Camera Settings in the camera.

Displaying the My Camera Settings

Display the existing My Camera Settings supplied with
ZoomBrowser EX.

1. Click the [Set to Camera] tab in the Camera Control
Window.

2. Click [Set My Camera].

The My Camera window displays.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• If ZoomBrowser EX’s Main Window is open, you can display the
Camera Control Window by clicking [Acquire & Camera
Settings] in the task area, followed by [Connect to Camera].
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3. Switch between the [Setup as a theme] and [Set
individually] tabs, and in the [Set individually] tab,
switch the options in the Data Type category.
The My Computer list displays the images and sounds.
The Camera list displays the My Camera Settings currently in
the camera (only the editable settings are shown).

Setting the My Camera Settings (2/8)
○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• Theme settings are a collection of My Camera Settings with
something in common.

• You can change all of the My Camera Settings—the start-up
sound, the start-up image, the shutter sound, the operating
sounds, and the self-timer sound—on the camera in one easy
step by selecting the [Setup as a theme] tab and saving the
desired theme set to the camera.

• You can also add new files as My Camera Settings to the
Computer list (the procedure is explained later in this section).

• Pre-prepared My Camera Settings can be found on the disk on
which ZoomBrowser EX was installed. Open the following
sequence of folders: [Program Files], [Canon], [CameraWindow]
and [MyCameraFiles].

• You can also open the My Camera window by clicking the [Edit]
menu and selecting [Manage My Camera]. However, the
buttons in the window will be slightly different from those
shown to the left.

You can save the files that appear in the My Computer list to
your camera.

Changes the type
of data.

My Camera Settings that are
already on your computer display
here.

My Camera Settings
in your camera
display here.

Switches between theme
sets and individual settings.
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Setting the My Camera Settings (3/8)

Saving the My Camera settings to the camera

This topic explains how to save the previously recorded My
Camera Settings files to the camera.

1. Select the [Setup as a theme] tab in the My Camera window.
To set the My Camera Settings individually, click the [Set
individually] tab instead and select the respective settings, such
as the start-up sound or image, in the Data Type category.

2. In the My Computer list, select a setting you would
like to add to the camera.
When you select [Setup as a theme]:
The start-up image will preview in the area to the right and the
start-up sound, the shutter sound, the operation sound and the
self-timer sound will play in order.

When you select [Set individually]:
When you select a start-up image, it will be displayed in the
preview area to the right. When you select a sound file, it will
automatically be played.Select the [Setup as a theme] tab.
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3. Select the settings file you would like to replace in the
Camera list and click [Save to Camera].
When you click [OK] in the confirmation dialog, the settings file
in the camera will now be replaced with the one you specified
from the computer.

Setting the My Camera Settings (4/8)

Repeat Steps 1-3 to replace all the settings files with those you
wish to save to the camera.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• Please note that the original settings file in the camera is
overwritten and permanently erased. To restore the original
settings file, you must add it once more to the camera. Before
you overwrite a settings file in the camera, confirm that it
appears in the My Computer list.

• The [Return to factory default settings]
button displays for some camera models.

4. Click the [Close] button to close the dialog.
This concludes the procedure for adding settings to the camera.

See the user guides for your camera for instructions on
changing the start-up image, start-up sound and other settings.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• Do not break the connection while the My Camera settings
are being saved to the camera.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• To delete settings files in the Camera list, select the file and click
the [Delete] button. For cameras that can only register one My
Camera setting, you cannot delete the setting file.

• You can check a sound file in the camera by clicking [Play].

A Select the setting you want
to replace.

B Click this.

Click here to delete a file from the list.

Click here to check a sound file in the
camera.

Displays the camera settings when
an image file is selected.
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Setting the My Camera Settings (5/8)

Saving the Settings to the Computer

In this procedure, opposite to the previous one, you save the
My Camera Settings to the computer from the camera.

1. Click the [Setup as a theme] tab in the My Camera
window.
To set the My Camera Settings individually, click the [Set
individually] tab instead and select the respective settings, such
as the start-up sound or image, in the Data Type category.

2. Select the setting you would like to copy from the
Camera list.

■ If you selected the Theme tab in Step 1
The preview image will display in the area to the right and the
start-up sound, the shutter sound, the operation sound and the
self-timer sound will play in order.

■ If you selected the [Set individually] tab and the start-
up image in the Data Type category in Step 1
The start-up image will display in the area to the right. If you
selected a sound, it will automatically play.

3. Click [Save to PC].

4. Assign a name to the settings file and click [OK].
The settings file will copy to the computer disk. If there is a
settings file with the same name, it will be over-written.

Repeat steps 1-4 as required to save the settings files you wish
to copy to the computer.

5. Click [Close] to close the My Camera window.
This completes the copying process.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• Do not break the connection while the My Camera settings
are being saved to the camera.
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Using Other My Camera Settings

You can obtain or make My Camera Settings files other than
those provided with ZoomBrowser EX by the following
methods.

■ Using My Camera Maker to Create Settings Files
You can use My Camera Settings files that you create with the
supplied program, My Camera Maker. Files created with this
program automatically display in the My Camera window. The
program features are explained in “Using My Camera Maker” in
Chapter 6.

■ Using Other Software to Create Settings Files
You can add images or sound files recorded with the camera as
My Camera Settings files after processing them with image or
sound processing programs other than My Camera Maker. You
will have to manually add these files to the My Camera
window. The next topic explains the procedures for adding
them and some restrictions for creating them.

Setting the My Camera Settings (6/8)

Type 

Start-Up Sound

Operating Sound

Self-Timer Sound

Shutter Sound

11.025 kHz

1.0 sec. or less

0.3 sec. or less

2.0 sec. or less

0.3 sec. or less

Duration in Seconds

8.000 kHz

1.3 sec. or less

0.4 sec. or less

2.0 sec. or less

0.4 sec. or less

Creating and Adding Files as My Camera Settings

This topic explains the requirements for files created as My
Camera Settings using image editing and sound processing
programs and how to add them to the My Camera window.

■ File Requirements for My Camera Settings
Use the following settings when creating image files as start-up
images using an image editing program.

Compression Method: JPEG (Baseline JPEG)
Data Sampling: 4:2:0 or 4:2:2
Pixels (w x h): 320 x 240 pixels

Use the following settings when creating sound files using a
sound processing program.

Compression Method: WAVE (Monaural)
Quantifying Bits: 8 bit
Sampling Frequency: 11.025 kHz or 8.000 kHz

Use the following chart as a guideline for the length of sound
files recorded with the camera.
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Adding New Files to the My Camera Settings

1. Create an image file or sound file that will be used as
a My Camera Settings file and save it to the computer.

2. Click the [Edit] menu in ZoomBrowser EX’s Main
Window and select [Manage My Camera].

3. Click the [Set individually] tab in the My Camera window
and switch the Data Type.

Click the [Set individually] tab in the My
Camera window and switch the Data Type.

Setting the My Camera Settings (7/8)
4. Click [Add File].

5. In the Open dialog, select the file you created and
click [Open].
The selected file will appear in the My Computer list.

This concludes the process for adding the new settings.
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6. Connect the camera to the computer with the
interface cable and click [Connect to Camera].

You can save the newly created settings to the camera using
the procedures described in the Saving the My Camera Settings
to the Camera section.

The [Connect to Camera] option cannot be selected when a
wireless connection is used. Close the My Camera window, and
and then select it from the Camera Control Window that
appears for a wireless connection.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• To delete a settings file, select it and click the [Delete] button
beneath the My Computer list.

Setting the My Camera Settings (8/8)
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Checking and Changing Camera Settings

3. After you have checked the camera settings and made
necessary changes, click [OK].

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• If ZoomBrowser EX’s Main Window is open, you can display the
Camera Control Window by clicking [Acquire & Camera
Settings] in the task area, followed by [Connect to Camera].

You can check and change camera settings from the computer.

1. Click the [Set to Camera] tab in the Camera Control
Window.

2. Click [Confirms/changes camera settings].

This will open the camera settings window. The settings shown
at the right can be adjusted with this window.

Type the name of the owner of the camera here.
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Copying Images to the Camera (1/2)
You can copy images (JPEG only) from the computer to the memory
card in the camera.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• If you are using a memory card reader, you cannot download
images to the memory card.

1. Click the [Set to Camera] tab in the Camera Control
Window.

2. Click [Uploads images to the camera].

3. Select files to copy and click [Open].

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• If ZoomBrowser EX’s Main Window is open, you can display the
Camera Control Window by clicking [Acquire & Camera
Settings] in the task area, followed by [Connect to Camera].

• You can also copy more than one image at a time.

4. If a window similar to the following one opens, select
an option as required and click [Add].
This will copy the image.

A dialog will appear, allowing you to select image files.

Select this to upload the
image to the camera
without resizing.

Select this to resize the image before uploading it to the camera.
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○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• If multiple images have been selected, then the selected resizing
option will affect all the selected images.

• You can select the [Add image as is] option only when
uploading JPEG images based on the DCF standard. Select [Send
after changing the image to VGA size (640X480 dots)] for all
other images.

• RAW images and movies cannot be uploaded to the camera.

Copying Images to the Camera (2/2)
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Operating the Camera Shutter from the Computer (1/4)
This section explains the procedures for remote shooting, the process of
operating the camera shutter remotely from a connected computer. Remote Shooting Procedures

Begin the procedure with the camera connected to the
computer and placed in the correct mode for connection.

1. Click the [Remote shooting] tab in the Camera
Control Window.

2. Click [Starts Remote Shooting].

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• When the Main Window is open, you can open the Camera
Control Window by clicking [Acquire & Camera Settings],
followed by [Connect to Camera].

3. When the Select Folder dialog displays, specify a
destination for the recorded image and click [OK].
The RemoteCapture Task window will open.

4. Click the [Release] button.
The image will record.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• See the user guides for your camera to check whether your
camera supports the remote shooting function or not.

• On camera models with lens covers, open the lens cover
before remote shooting.

• Ensure that you turn off your computer’s standby feature
before you begin remote shooting. The results cannot be
guaranteed if the computer enters the standby mode while
remote shooting.

• Except for the shutter button, the camera’s buttons and
switches, including the zoom, cannot be manually operated
while the camera is being remotely controlled.

• The time lag between pushing the shutter button and the
release of the shutter is slightly longer for remote shooting
compared with the normal mode of operation.

• Depending upon your camera model, a program different
from the one shown here may start up. Please refer to the
manual for the software supplied with your camera if this
occurs.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• See the Help menu (it can be opened from the [Help] menu in
the remote shooting window) for detailed operating procedures
for remote shooting.

The image captured by the
camera displays here.

Switches between showing or hiding the image.
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Operating the Camera Shutter from the Computer (2/4)

Features of the RemoteCapture Task Window

Releases the camera shutter
(you can also release it by pressing the camera’s shutter button
or the space bar on the keyboard).

Selects the image’s recording size and compression.
Sets the rotation setting of the image being recorded.
This setting cannot be adjusted if the [Auto Rotate] function of
your camera’s shooting mode is set to [On].

Viewfinder

Sets the camera’s zoom.

Turns the viewfinder display on or off.

Refreshes the exposure, focus and white balance settings
(these settings remain fixed until this button is clicked).

Sets the shooting settings. It is divided into the “Field angle/
flash” tab and the “Shooting settings” tab.
(The settings categories vary according to your camera model.)

Switches between showing and hiding
the viewfinder and the detailed
settings sections.

You can add a comment to an image
by clicking to place a check mark
here and inputting text in the box
below.
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Operating the Camera Shutter from the Computer (3/4)

Other Remote Shooting Features

■ Interval Timer Shooting
Interval timer shooting is the method of capturing images in
which a set number of frames is recorded at set intervals of time.

Click the [Shooting] menu in the
remote shooting window and select
[Interval Timer Shooting]. Click [OK] in
the warning message to open the
window shown to the left. Set the
values and click [Start] to start shooting.
(Interval: between 5 seconds and 60
minutes; Frames: 2 or more)

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You may not be able to record at the set interval if it is too short
for the camera to transfer and save the image data.

■ Timer Shooting
Timer shooting is the method by which a single image is
recorded after a set number of seconds.

Click the [Shooting] menu in the
RemoteCapture Task window and select
[Timer Shooting] to open a window like
the one shown here. Set the number of
seconds for the delay and click [OK]. The
timer may be set to a range from 2
seconds to 30 seconds.

■ Saving and Recalling Shooting Settings
You can save the current zoom settings and the settings in the
“Field angle/flash” and “Shooting settings” tabs by clicking the
[File] menu in the RemoteCapture Task window and selecting
[Save Shooting Settings].

Later when you wish to recall those settings, click the [File]
menu in the RemoteCapture Task window and select [Batch
Shooting Settings].

■ Displaying the Subject on the Camera’s LCD Monitor
You can use the camera’s LCD monitor or a television
connected to the camera to view the subject while shooting
remotely.

Click the [Camera] menu in the
RemoteCapture Task window and select
[Camera Display Settings] to open a window
like the one shown here.

Select [Video Out terminal] or [Camera’s
LCD monitor] and click [OK].

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• See the user guides for your camera for information about
connecting the camera to a TV.
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Operating the Camera Shutter from the Computer (4/4)

Remote Shooting Default Settings

You can display the default settings for remote shooting by
clicking the [File] menu in the RemoteCapture Task window and
selecting [Preferences].

■ File Settings Tab

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• If you click [Computer only] in the Save Images On category, you
can record images when the memory card in the camera is full
and will not accept more images or when it is not present.

■ Options Tab

Sets whether images are saved only to
the computer, or also to the camera’s
memory card.

Folder to which recorded images are saved
(This is the folder specified when remote shooting was started)

Sets the root file name for saved
images.
For example, if you type “Capture,”
file names are automatically assigned
in ascending order starting from
“Capture_00001.jpg”.
You can also change the number of
assigned digits and the starting
number.

You can release the shutter using the
key specified here.

Click to place a check mark here to
have the RemoteCapture Task
window remain in front at all times.



Table of
Contents

Chapter 1
What is

ZoomBrowser EX?

Chapter 2
Downloading and

Printing Images

Chapter 3
What You Can Do with
a Camera Connected

Chapter 4
Viewing Images

Chapter 5
Organizing Images

Chapter 6
Using Supplementary

Features
Appendices Index

ZoomBrowser EX Software User Guide 55 Back Next

Selecting Folders (1/2)
This chapter explains the methods for displaying images with
ZoomBrowser EX.
This section explains the methods for using the Folder Area to select
folders containing the images you wish to view.

Favorite Folders and All Folders

Two tabs, titled Favorite Folders and All Folders, display in the
upper portion of the Folder Area.

If you select Favorite
Folders, the folders that
have been already
registered as your favorites
will display. You will find it
convenient to register a
folder that you use regularly
as a Favorite Folder.

If you select All Folders, all
the drives that are connected
to your computer will display
(along with their folders).

Selecting Folders

If you click a folder in the Folder Area, the images it contains
will display in the Browser Area. Use the  or  button to the
left of the folder name to hide or show the folder contents.

Folder Area Browser Area

The images in the selected folder will
display. (Images in subfolders within a
folder appear in a rectangular frame.)

Selected
Folder

Pre-Registered
Folders

Connected Drives

Mark indicating there are
newly downloaded images
in the folder.

Last Acquired
Images
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Selecting Folders (2/2)

Registering a Folder as a Favorite Folder

■ Favorite Folders Tab Selected
Click [Add] at the bottom of the Folder Area, select a folder in
the window that opens and click [OK].

■ All Folders Tab Selected
After you open the folder in the Folder Area that you wish to
register, click [Add to Favorites] at the bottom of the Folder
Area.

Alternately, you can click the folder and drag and drop it onto
the Favorite Folder tab.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• A heart symbol  appears on the icon of folders that have
been registered as favorites.

Deregistering a Favorite Folder

Select the Favorite Folders tab and the folder you wish to
deregister, and click [Remove] at the bottom of the Folder Area.
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Changing the Display Mode (1/3)
You can change the display mode in the Browser Area for ease of use.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• Folders display below the Task Area in the Main Window. Select
either [Favorite Folders] or [All Folders]. The images in the folder
you click will display in whichever mode you select.

■ Zoom Mode
Displays all images in folders as thumbnails (tiny versions). Since
many images can be shown together, it is a convenient mode
for visually searching for an image amongst all the rest.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can change the zoom speed. The method is explained in
“Customizing Preferences (1/4)” in the Appendix.

Three Display Modes

The three display modes for the Browser Area are the Zoom
mode, Scroll mode and Preview mode, which can be switched
by clicking the tabs at the top of the Browser Area. The Zoom
mode is the default mode.

You can change the zoom level
for the entire Browser Area.

Images within subfolders also display.
(The rectangular frame indicates a subfolder.)
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Changing the Display Mode (2/3)
■ Scroll Mode

This mode is convenient for checking images in several folders
simultaneously. If the displayed folder is one or more level deep
in the hierarchy, the thumbnails of the images in the folder will
display too.

You can change the thumbnail size.

The image thumbnails will display
in folders that are up to two levels
below the selected folder.

The folder icon shows for
folders that are three or more
levels below the selected folder.

Example of a Second Level Folder

Display the images and subfolders
by double-clicking the folder icon.

Example of a Level Zero Folder (Default Settings)
The folder is displayed as an icon. You can open it by double-
clicking it.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• The methods for changing a folder’s hierarchical level are
explained in “Customizing Preferences (1/4)” in the Appendix.
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Changing the Display Mode (3/3)
■ Preview Mode

In this mode, image thumbnails (tiny versions) appear at the
bottom of the Browser Area while a larger-scale image of the
selected thumbnail and the information panel (which shows the
image information) appear in the upper portion. You can
advance to other images by clicking the Previous and Next
buttons.

Selected
Thumbnail

Click here to hide the
information panel.

Moves to the
next image.

Selected Image Information Panel
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Changing the Displayed Folder (1/3)

Opening a Folder Deep in the Hierarchy

■ Zoom Mode
When you move the mouse cursor over a folder in the Browser
Area, the  appears at the upper right. Clicking the  zooms
in that folder. (You can also zoom a folder by double-clicking an
area where there is no image.)

By repeating this step, you can go deeper and deeper into the
folder hierarchy.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can use the  (Back) button to restore the previous window
and the  (Forward) button to advance to the next.

• The deeper the folder level, the darker the background color
used to indicate a folder frame.

■ Scroll Mode
If the folder level is set to [1] or more, click  to the left of the
folder in the Browser Area to display the images or subfolders
within that folder.

By repeating this step, you can go deeper and deeper into the
folder hierarchy.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• The deeper the folder level, the darker the background color
used to indicate a folder frame.

Clicking this symbol zooms
in on that folder.

Double-clicking here
displays the images in the
folder.

Clicking the  to the left
of the folder name displays
the folder images.

Lower Level Folder
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■ Preview Mode
At the bottom of the Browsing Area, double-click the icon of a
displayed folder to open it and view its images and subfolders.

By repeating this step, you can go deeper and deeper into the
folder hierarchy.

Returning to a higher level in the folder hierarchy

When you are deep in the folder hierarchy, you can use the 
(Up) button to go back to a higher level.

The example below shows the zoom mode, but the procedure
is the same for the other display modes.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• By using the  (Back) or  (Forward) button, you can move
to the folder displayed immediately before, or to the folder
displayed before the  (Up) button was clicked.

Changing the Displayed Folder (2/3)

Click the [Up] button to
zoom out the folder at
that level.

Double-click the folder
icon to display its
images and then click
on one to preview it.
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In Zoom mode, you can do this

There are more convenient ways to use the Zoom mode.

■ Zooming in by skipping levels
If you click the  symbol on a folder displayed in the Browser
Area, you can skip over the intervening folders and zoom right
in on it.

■ Right-Clicking to Zoom In or Out
Right-click on any clear area in the Browsing Area to display a
menu like that below. Select the respective [Zoom In to Folder]
or [Zoom Out of Folder] option from this menu.

Changing the Displayed Folder (3/3)

Clicking this symbol skips over
folders to zoom in directly on
the intended folder.
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Changing the Main Window Display Mode (1/5)
This section explains methods for filtering the images shown in the
Browser Area and how to display information other than the file name
shown with thumbnails.

Filtering the Thumbnails Displayed

You can filter the images displayed in the Browser Area.

Click [Filter Tool] and select a criterion to display only the
images corresponding to that criterion.

To display all images again, click [Filtering: On].

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• See “Setting Star Ratings” in Chapter 5 for the Star Rating
settings procedures.
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Setting the Information Shown with Thumbnails

You can specify the image information shown beneath
thumbnails.

Click the  (Show Information) menu in the Display Control
Panel to open the submenu and place a check mark beside the
information category you would like displayed.

Place a check mark
beside the desired
information category.

Example with a check
mark placed beside the
File Name, Shooting Date
and Star Rating categories.

Changing the Main Window Display Mode (2/5)

Sorting Thumbnails

You can set the criteria by which thumbnails are ordered.

Click the [View] menu, open the [Sort by] submenu and select a
sorting criterion.

Place a check mark
beside the sorting
criterion.

You can also sort by
ascending or
descending order.
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Changing the Main Window Display Mode (3/5)

Changing the Thumbnail Display Size
(Scroll Mode Only)

In the Scroll mode, you can change the thumbnail display size
by moving the slider above the image either left or right.

The thumbnail
display size changes.
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Changing the Display Magnification
(Zoom Mode Only)

■ Using the Display Size Slider
In the zoom mode, you can change the display magnification
for the entire Browser Area by moving the slider above the
image either left or right.

■ Using the Zoom In/Zoom Out Buttons
If you click  (Zoom In) on the Display Control Panel, the
mouse pointer appears with a plus (+) symbol at its center. If
you click on the Browser Area in this state, the display zooms in
(magnified display), centered on the clicked area.
Similarly, if you click  (Zoom Out) and perform the same
actions, the display will zoom out (reduced display).

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• When the display magnification level is
high, a Navigator window such as the one
at the right appears. The area enclosed by
the red marks indicates the area of the
image shown in the Browser Area.

■ Changing the Display Position
After clicking the [Pan] button, you can change the portion of
the Browser Area displayed by clicking in the Browser Area and
dragging the mouse cursor.

Changing the Main Window Display Mode (4/5)

You can also change it by moving the red symbols in the
Navigator or by clicking somewhere other than the red symbols.
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Changing the Main Window Display Mode (5/5)

Changing the Task Area and
Folder Area Display Modes

You can hide the Task Area and Folder Area to make the
Browser Area larger.

■ Hiding the Task Area and Folder Area
Clicking the [ < ] on the left of the Browser Area hides the Task
Area and Folder Area and widens the Browser Area. To return
to the original display mode, click [ > ].

■ Hiding the Task Area
Clicking the  button at the upper right of the Task Area,
hides the Task Area and widens the Folder Area. To return to
the original display mode, click the  button.
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Checking Images in a Pop-Up Window
You can check images by positioning the mouse pointer over a
thumbnail or folder to display a pop-up window. You can confirm that
you have the right image when many thumbnails are displayed in the
Browser Area.

Checking Folders

When you position the mouse pointer over a folder, the
thumbnails of the first four images in the folder display. The
folder name also displays in the pop-up window.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can also hide the pop-up window by clearing the check

mark in the  (Show Information) menu from the [Show

Mouse Over Windows] option.

Checking Thumbnails

When you position the mouse pointer over a thumbnail, an
enlarged thumbnail and its file name display.

Pop-Up Window

Pop-Up Window
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Opening Images
This procedure involves opening the Viewer Window from the Browser
Area to open images.

How to open an image

Double-click the image that you want to open in the Browser
Area to open it in the Viewer Window.

Opening multiple images

You can select multiple images by pressing and holding the
[Ctrl] key while clicking on successive images. You can also
select a series of adjacent images by pressing and holding the
[Shift] key while clicking on the first and last images.
Once you have selected multiple images, you can open all of
them at once by clicking  (View Image).

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• Using the [Select Images] menu in the Display Control Panel is
convenient if you intend to select or deselect all images.

Double-click the image
you want to see.
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Using the Viewer Window (1/5)
This section explains how to use the Viewer Window.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• If you select multiple images and display them in the Viewer
Window, you can click the Previous or Next button to move the
selection between images. If you select one image and display it
in the Viewer Window, you can switch to other images within
the same folder by clicking these buttons.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• When the display magnification level is
high, a Navigator window such as the
one at the right appears. The area
enclosed by the red marks indicates the
area of the image shown in the Browser
Area. You can change the area displayed
in the Viewer window by moving the red
symbols or by clicking anywhere but on
the red symbols.

Opening the Previous or Next Image

You can display the image before or after the displayed image
by clicking the Previous or Next button in the Viewer Window.

Changing the Display Magnification

You can change the display magnification by moving the slider
above the image either left or right. To match the display size to

the Viewer Window size, click  (Fit to Window).

Using the Full Screen Display

You can display an image at the full screen size by clicking the
[Show Image Full Screen] button in the Viewer Window. To
restore the standard display, click the image or press any key on
the keyboard.
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Using the Viewer Window (2/5)

Displaying Multiple Images

You can display and compare two to four images at once in the
Viewer Window by clicking the [Number of files] button. Use
this feature to compare images of the same subject shot with
different settings or from different angles.

When multiple images are displayed in the Viewer Window,
clicking the Back and Next buttons replaces all the images with
the next set of images before or after the displayed images.

Synchronizing Multiple Images

When multiple images are displayed in the Viewer Window,
clicking [Synchronize] sets the display magnification and
position on the image to the same for all images.

Currently selected
image.

Example of a 4-Image Display

Synchronizes the display magnification
and display position.
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Using the Viewer Window (3/5)

Displaying Shooting Information for Images

The shooting information for images displays when you click
the [Show Shooting Information] button.

Shooting Information

Displaying the Autofocus Frame

When you click the [Show Auto Focus Points] button, an
autofocus frame showing the focus position at the time of
shooting will appear.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• Please see the guide for the software bundled with your
camera to see whether your camera supports the display of
the autofocus frame.

Autofocus Frame

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• For instructions on how to change the information display
category, see “Customizing Preferences” in the Appendices.
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Using the Viewer Window (4/5)

Converting and Displaying RAW Images

RAW images display in the Viewer Window like standard
images, but not using the full RAW image data. An easily
displayed version is used. Click the [Display Original Image] to
convert the original RAW data and display it in the Viewer
Window.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• RAW images cannot be edited or saved in the Viewer Window.
See “Converting RAW Images” in Chapter 6 regarding editing
and saving RAW images.

Extracts stills from movies.
(Windows XP only)

Buttons for controlling movies.

Playing Movies

Movie control buttons appear at the window’s bottom left
when you display a movie in the Viewer Window. Use these
buttons to start/stop movies.
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Printing Displayed Images

You can print the displayed image by clicking the [Print] button.
See “One Photo Per Page” in Chapter 2 for printing instructions.

Playing Sound Files

When you select a sound file recorded with the camera’s Sound
Recorder feature in the Viewer Window, the sound file control
buttons will appear at the bottom left of the window. You can
use these buttons to play and stop sound files.

Buttons for controlling sound files.

Closing the Viewer Window

Click  to close the Viewer window.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• See “Editing Images” in Chapter 6 for information on the
Viewer Window’s editing function.

Using the Viewer Window (5/5)
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This chapter explains the features in ZoomBrowser EX for managing
images.
In this section we reintroduce the methods for selecting images in the
Browser Area as one of the basic image management procedures.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• To deselect an image, press and hold the [Ctrl] key while clicking
again on the selected image.

Selecting All the Images

You can select all the images displayed in the Browser Area at
once by clicking the  (Select) menu in the Display Control
Panel and selecting [Select All].

Deselecting All Images

Clicking  in the Display Control Panel and selecting [Clear
Selection] from the menu deselects all the images.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can change the image selection method to the Toggle
Selection method. See the “Selection Tab” section in
“Customizing Preferences (2/4)” in the Appendix for instructions
on changing the selection method.

Selecting a Single Image

Click on an image to select it. The background color of the
selected image(s) will change to blue.

Selecting Multiple Images

You can select multiple images by pressing and holding the
[Ctrl] key while you click on successive images. You can also
select a series of adjacent images by pressing and holding the
[Shift] key while clicking on the first and last images.

Selecting Images
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Setting Star Ratings (1/2)
This section explains the procedures for setting Star Ratings used in
image searches and to display subsets of images. Other Settings Methods for Star Ratings

■ Menu Method
Select the image in the Browser Area, click the [Edit] menu and
select [Change Star Rating] in the submenu, followed by your
ratings choice.

■ Properties Window Method
Select the image in the Browser Area and click  (Properties).
Click a Star Rating ✩  in the properties window that appears to
select a rating for the image.

What is a Star Rating?

You can assign one of three ratings to an image. When a
camera image is downloaded to the computer it is assigned a
two-star (✩✩ ) rating.

Setting the Star Rating

With the Browser Area display mode set to [Preview Mode],
select the rating for an image by selecting the image and
clicking a ✩  in the Star Rating section of the information display
panel.



Table of
Contents

Chapter 1
What is

ZoomBrowser EX?

Chapter 2
Downloading and

Printing Images

Chapter 3
What You Can Do with
a Camera Connected

Chapter 4
Viewing Images

Chapter 5
Organizing Images

Chapter 6
Using Supplementary

Features
Appendices Index

ZoomBrowser EX Software User Guide 77 Back Next

Setting Star Ratings (2/2)
■ Viewer Window Method

Display the image in the Viewer Window and click a Star Rating
✩  to select a rating for the image.

■ Slide Show Method
While a slide show is playing, click a ✩  appearing at the
window’s bottom right to select the rating for the displayed
image.



Table of
Contents

Chapter 1
What is

ZoomBrowser EX?

Chapter 2
Downloading and

Printing Images

Chapter 3
What You Can Do with
a Camera Connected

Chapter 4
Viewing Images

Chapter 5
Organizing Images

Chapter 6
Using Supplementary

Features
Appendices Index

ZoomBrowser EX Software User Guide 78 Back Next

Assigning Keywords (1/2)
This section explains the procedures for assigning keywords to images
for searches.

What is a Keyword?

A keyword is information used to perform searches on images.
Select a keyword that matches the image content from the
keywords in categories such as People, Places, Events or Others.
For example, if you have an image from a family holiday to the
ocean, you might assign keywords such as Family in the People
category, or Beach in the Places category or Holiday in the
Events category.

Assigning Keywords

1. Set the Browser Area to the Preview mode and select
an image.

2. Click  to the left of Keyword in the information
display panel and then click [View/Modify Keywords].

The View/Modify Keywords window will display.

3. Place a check mark beside appropriate words in the
various categories, such as People, Places or Events,
and click [OK].

Place a check mark beside
appropriate keywords.

To add a new keyword, type
it in the box and click [+].
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Assigning Keywords (2/2)

Other Ways to Assign Keywords

■ Menu Method
Select an image in the Browser Area, click the [Tools] menu and
select [View/Modify Keywords].

■ Properties Window Method
Select an image in the Browser Area and click  (Properties).
Click  to the left of Keyword in the properties window that
appears and then click [View/Modify Keywords].

■ Add Keywords
Select a category from the list box, type a new keyword into
the text box at the bottom of the list and click [+].

■ Delete Keywords
Select a category from the list box, place a check mark beside
the keyword and click [Delete].

■ Restore Keyword List
This function restores the keyword list based on the keywords
assigned to images. This is convenient if you deleted a keyword
that was used in the past.

Managing Keywords

1. Click the [Tools] menu and select [Manage Keywords].
The Manage Keywords window will open.

2. Add, delete or restore keywords.
You can use the following features in this window.

Category
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Classifying Images
You can classify selected images into folders by the shooting dates.

1. Click [View & Classify] in the Main Window, followed
by [Classify into Folder].

2. Confirm that [1. Select Images] is selected, and select
the images to classify in the Browser Area.

3. Click [2. Specify Classification Settings] and set the
classification method.

4. Click [3. Finish].
The program will start classifying the images.

Select the
destination folder.

Select the
classification format
(folder structure).

Sample of an actual folder
name that will be created.

Select [Copy] to retain the original file
or [Move] to shift it to the new location.
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Renaming Images (1/2)
This section explains the procedures for changing an image name
(image file name).

A dialog similar to that below will appear.

2. Type a new name and click [OK].
The name will change.
You can also rename a sound that is attached to an image.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• Renaming an image in ZoomBrowser EX renames the actual
file on your PC.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• Because an extension (indicating the type of the file) is
automatically assigned, do not include an extension in the
name. (In the file named [xxx.JPG], for example, the [.JPG]
portion is called the file name extension.)

Using the Rename Function

1. Select an image, click the [File] menu and select
[Rename].

Using the Preview Mode

If you select an image in the Browser Area in Preview mode,
you can also change its name in the information panel.

B Click [Rename].

A Click an image to rename.
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Renaming Images (2/2)

Changing Multiple Image File Names

You can rename multiple image files at once.

1. Click [View & Classify] in the Main Window, followed
by [Rename Multiple Files].

2. Confirm that [1. Select Images] is selected, and select
multiple images in the Browser Area for renaming.

3. Click [2. Specify Rename Settings] and set the
renaming method.

Renaming Folders

1. Select a folder, click the [File] menu and select
[Rename].

2. Input a new name and click [OK].
The name will change.
If you select a folder in the Browser Area in Preview mode, you
can also change its name in the information panel.

Place a check mark here
if you wish a file with
the new name to be
created separately from
the original file.

Type the text in the
“new name” spot for
the type above.

Select a name type.

Set the number of digits and the starting number
for the number portion of the type selected above.

4. Click [3. Finish].
The program will start renaming the images.
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Searching Images (1/2)
You can search images using such criteria as Star Ratings, revision dates,
shooting dates, comments or keywords.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• For information about Star Rating settings, see “Setting Star
Ratings” and for information about keyword settings, see
“Assigning Keywords” in this chapter.

1. Click [View & Classify] in the Main Window, followed
by [Search].

2. Confirm that [1. Select Search Region] is selected, and
select a folder in the Browser Area.
To search all images and folders in the Browser Area, click 
in the Display Control Panel and select [Select All] from the
menu.

3. Click [2. Specify Search Conditions] and set the
conditions.

Sets whether images are searched
according to all the parameters or just one.

Clicking here allows you to hide the search parameters.

Set the search parameters here.
First, place a check mark in the parameter you wish to use.
Next, if you selected the modification or shooting date, set
the date range.
If you selected Star Rating, select a rank.
If you selected the keyword option, select the keywords.
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4. Click [3. Start Search] after you have set the param-
eters.
A set of images corresponding to the search parameters will
display.

5. Confirm the search results and click [4. Finish].
To modify the search parameters, repeat steps 3–4.

This concludes the search process.

When you click [OK] in the confirmation dialog, the “Search
Results” folder is created in the Main Window and displays the
images matching the search parameters.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• The original image will also be deleted when you delete an
image from the Search Results folder.

Searching Images (2/2)

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can select, print or copy the images in the Search Results
folder to another.

• Images will remain registered in the Search Results folder until
you close ZoomBrowser EX or perform another search.

• You can also perform a search by clicking the  (Search)
function button.
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Moving or Copying Images (1/4)
This section explains how to move or copy images between folders. It is
convenient to conduct these procedures in the zoom mode.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• Moving or copying images in ZoomBrowser EX affects the actual
location in which those images are stored on your PC.

Moving an image in the Browsing Area

You can move an image in the Browsing Area simply by using a
drag-and-drop operation.

A Drag the image you
want to move.

B Drop it at the
desired location.
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Moving or Copying Images (2/4)

Copying an image within the Browsing Area

To copy an image, before you drop the image you are dragging,
press and hold the [Ctrl] key and release the mouse button,
while still holding the key.

A Drag the image you
want to copy.

B While holding down the [Ctrl] key,
drop it at the desired location.
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Moving or Copying Images (3/4)

Moving or Copying an Image from
the Browsing Area to the Folder Area

You can move or copy images between different folders by
dragging them from the Browsing Area to the Folder Area and
dropping them in the target folder.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• To copy an image from the image folder you are in at the
moment to a different image folder, proceed the same way.
Hold down the [Ctrl] key before dropping the image and release
the mouse button while holding the key over the target library.

Copying by Dragging a File Icon from
a Windows Window

You can also copy an image by dragging its file icon from an
open Windows window and dropping it onto the ZoomBrowser
EX window.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• On the other hand, when you drag an image from the Browsing
Area of ZoomBrowser EX to Windows Explorer, the image is also
automatically copied.

A Drag the image you wish to move.

B Drop it in the target folder.

A Drag the image you
wish to move.

B Drop it in the target folder.
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Additional ways of moving or copying images

■ Moving or copying many images at once
You can select multiple images by pressing and holding the
[Ctrl] key while you click on successive images. You can also
select a series of adjacent images by pressing and holding the
[Shift] key while clicking on the first and last images.
Once the images are selected, you can move or copy them all
together with standard drag and drop procedures.

■ Moving or copying a complete folder
In addition to moving or copying individual images, you can
move or copy an entire folder. In the Zoom display mode, select
the folder by clicking inside it where there are no images. Then
move the folder by dragging and dropping it, or copy the folder
by first pressing down and holding the Ctrl key, and then
dragging and dropping the folder.
See “Changing the Display Mode” and “Selecting Folders” in
Chapter 4 for information about display modes and folder
selection.

■ Copying from the menu
Select one or more images, click the [Edit] menu and select
[Copy]. Next, select the target folder in the Folder Area, click
the [Edit] menu and select [Paste]. (This operation is not
available with Windows 98 SE.)

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can select all the folders and images presently displayed in

the Browser Area by clicking  in the Display Control Panel
and selecting [Select All] from the menu or by clicking the [Edit]
menu and selecting [Select All].

Moving or Copying Images (4/4)
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Deleting Images (1/2)
This section explains how to delete images and folders you no longer
need.

How to delete an image

1. Select an image in the Browser Area to delete.

2. Click  (Delete).

3. Click [Yes] when a confirmation dialog like the one
below appears.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• Deleted images can be restored from the Recycle Bin on the
Windows desktop. After you restore the images, click the [View]
menu in ZoomBrowser EX and select [Refresh Current Folder] to
display the images in their original location. Please note,
however, that the link between images and sound memos
cannot be restored after the images are recovered from the
Recycle Bin.

A Click an image. B Click [Delete].
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Other ways of deleting images

■ Deleting multiple images
You can select multiple images by pressing and holding the
[Ctrl] key and clicking on successive images or by pressing and
holding the [Shift] key while clicking on images. You can delete
multiple images at once by selecting them and clicking 
(Delete).

■ Deleting images from the File menu
Click an image. Then, click [Delete] on the [File] menu.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• To completely delete images from the computer after
completing the procedures above, double-click the [Recycle Bin]
on the Windows desktop to open it and, in the Recycle Bin Task
section, click [Empty Recycle Bin]. (With Windows 2000/
Windows Me/Windows 98 SE in web page view mode, click
[Empty Recycle Bin] at the left side of the window.)

Deleting Images (2/2)

Deleting Folders

1. Select a folder in the Browser Area to delete.

2. Click  (Delete).

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• All of the actual images and subfolders in a folder are deleted
from the computer in this procedure.
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Rotating Images
This topic explains the procedures for rotating images. Under Windows XP,
movies can also be rotated.

How to rotate an image

1. Select an image to rotate.

2. Click  (Rotate).
The rotation settings window will display.

are rotated in the display only. The image
data itself is not rotated for these images.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

3. Set the rotation direction and angle and click [OK].

A symbol similar to that at the right will display for images that

Selects the direction and
angle of rotation.

Place a check mark here to change
the orientation of the image data
itself. (Still images only)

• You can rotate the original image to match the orientation of
the displayed image by clicking the [Edit] menu and selecting
[Rotate According to Rotation Information] (Still images only).
If a movie cannot be rotated this way, rotate it using the Task
Area [Export] button and [Export Movie] option.

Other ways of rotating images

■ Rotating multiple images
You can select multiple images by pressing and holding the
[Ctrl] key and clicking on successive images or by pressing and
holding the [Shift] key while clicking on images. You can rotate
multiple images at once by selecting them and carrying out the
rotation procedure.

■ Using the Menu to Rotate Images
Rotate images by selecting the image, clicking the [Edit] menu
and selecting [Rotate Image] from the submenu and a direction
of rotation.
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This procedure is for viewing various types of information about the
selected image.

Viewing Image Properties (1/3)

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○
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• Images shot with the camera and then processed and saved by
another editing program may lose the shooting information.

• If you select multiple images and display the Properties window,
clicking [Previous] and [Next] switches between the Properties
windows for the images in the selection.

Viewing Information in the Properties Window

1. Select an image in the Browser Area in Zoom or Scroll
mode.

2. Click  (Properties).
The Properties window will display.

You can view various types of information in this window, such
as the image revision date and file size, shooting date and time
and camera shooting settings. In addition, you can change the
file name, set Star Ratings and keywords, and type comments.
Click  to close the Properties window.

You can rename the file.

You can play a sound if one is
attached to an image.

Place a check mark here to
prevent images from being
overwritten or deleted.

Type a comment.

Assigns keywords.

Histogram

The information displayed here
will vary according to your
camera model and the settings
used at the time of shooting.

You can display the image before
or after the displayed image.

Click here to show or hide more categories.

Sets Star
Ratings.

Displays
the
Viewer
Window.
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Viewing Information in the Preview Mode

If you set the display mode to the Preview mode and select an
image, you can view the information for that image. You can
view various types of information about the image in this
window, including the revision date or file size, shooting date
and time, and the camera shooting settings. In addition, you
can change the file name, set Star Ratings and keywords, and
type comments.

Viewing Image Properties (2/3)

Place a check mark here to
prevent images from being
overwritten or deleted.

The information displayed here
will vary according to your
camera model and the settings
used at the time of shooting.

Histogram

Assign a keyword.

You can play a sound if one
is attached to an image.

You can rename
the file.

Type a comment.
Sets Star Ratings.

Click here to show or
hide more categories.

You can display the
image before or after
the displayed image.
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Viewing Information in the Viewer Window

Shooting information will display overtop the image when you
click [Show Shooting Information] when an image is displayed
in the Viewer Window.

Viewing Image Properties (3/3)
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• The methods for changing the font type and size for the
displayed information are explained in “Customizing
Preferences” in the Appendices.

Shooting Information
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This section explains how to create a new folder within an existing one. 3. Type a name for the new folder and click [OK].
You have created a new folder.

Creating Folders

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○
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• See “Renaming Images (2/2)” for the procedures for changing
folder names.

• See “Deleting Images (2/2)” for the procedures for deleting
folders.

Creating Folders

1. Select a folder in the Folder Area.
You will be creating a new folder within the folder selected
here.

2. Click the [File] menu and select [New Folder].
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Refreshing Folders
This section explains how to refresh or update a folder.

Refreshing Folders

Click the [View] menu and select [Refresh Current Folder]. This
will update ZoomBrowser EX’s information about all the folders.

What Does It Mean to Refresh a Folder

Adding, moving, copying or editing an image or a folder within
ZoomBrowser EX ensures that it is updated and appears
correctly in the Browsing Area.

However, the information ZoomBrowser EX possesses and the
actual file contents can be different when an image file is
moved or copied using Windows functions or edited with a
separate program.
In this case, the “current state of the folders” has to be
checked and updated. This is what is meant by refreshing a
folder.
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This chapter explains the methods for handling images managed by
ZoomBrowser EX.
This section explains the procedures for editing images displayed in the
Viewer Window.

Editing Images (1/10)

■ Red Eye Correction
Use this to correct images in which people’s eyes appear red.

■ Auto Adjustment
Use this to automatically adjust the image color balance.

About the Editing Features

You can perform the following editing operations in the Viewer
Window.

■ Color/Brightness Adjustment
Use this to change image appearances by adjusting the
brightness, saturation, contrast, RGB (red, green, blue) intensity,
levels, and tone curve.

■ Sharpness
Use this to emphasize and clarify the outlines of people and
objects.

■ Trim
This function trims portions of images. Use it to cut away
unwanted parts of the image.

■ Insert Text
Use this to write text on images.

■ Edit with External Image Editor
See “Editing Images with Other Programs” in this chapter.

The procedures for these editing features are explained starting
from the next page.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• These editing procedures cannot be used on RAW images or
movies.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○
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• You can also edit images by selecting [Edit] followed by [Edit
Image] in the Task Area of the Main Window.
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Editing Images (2/10)

Red Eye Correction

This corrects the red portion of eyes that appear red. Click 
(Edit) in the Viewer Window and select [Red Eye Correction] to
open the red eye correction window.

■ Auto Mode

1. Select [Auto Mode] and click [Start].
Red eyes will automatically be corrected.

2. Click [OK] when it finishes correcting.

■ Manual Mode

1. Select [Manual Mode].

2. Move the mouse cursor over the red eye portion and
click the relevant portion.
When you position the mouse pointer over red eyes, the
corresponding area will be highlighted.

3. Click [OK] when it finishes correcting.

Select this to have it automatically
perform the red eye correction.

You can change the display magnification.

Click [Undo All] to restore the
image to its pre-correction
state.

Click [Undo] to cancel the
action immediately preceding.

Click [Redo] to reinstate an
action canceled with the Undo
button.

You can compare the pre-correction image and
the post-correction image by placing a check mark
here and having the pre-correction image appear.

Select this to choose manual
red eye correction.
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Editing Images (3/10)

Auto Adjustment

Automatically adjusts the image color balance and brightness.

1. Click  (Edit) in the Viewer Window and select [Auto
Adjustment].
The Auto Adjustment window will open.

2. Click [Auto Adjust Image].

You can change the display magnification.

If you add a check mark, you can
switch between and compare the
pre-adjustment image and the
post-adjustment image.

3. Click [OK].
This completes the auto adjustment process.
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Editing Images (4/10)

Color/Brightness Adjustment

Adjusts the brightness, saturation, contrast, RGB intensity, levels
and tone curve.

1. Click  (Edit) in the Viewer Window and select
[Color/Brightness Adjustment].
The Color/Brightness Adjustment window will open.

2. Select an adjustment method in the next section,
make the adjustments in each window and click [OK].

Select an adjustment method here.

You can change the display
magnification and display area.

Click [Undo All] to restore the image to its pre-adjustment state.
Click [Undo] to cancel the action immediately preceding.
Click [Redo] to reinstate an action canceled with the Undo button.

Adjusts the brightness,
saturation and contrast.

■ Common Elements for Each Adjustment Method

■ Color Adjustment Window
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Editing Images (5/10)
■ RGB Adjustment Window

You can adjust the RGB (red, green, blue) intensity.
■ Level Adjustment Window

You can adjust an image’s highlights (brightest portions),
shadows (darkest portions) and mid-tones while viewing its
histogram.

Selects the channel to adjust.

Auto adjusts the levels. Histogram

Adjusts the image shadows (darkest portions),
mid-tones and highlights (brightest portions).

Displays the pre-
adjustment image.

Use this to
repeat the same
adjustment.

Adjusts the post-adjustment
shadow and highlight levels.
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Editing Images (6/10)
■ Tone Curve Adjustment Window

You can adjust image brightness and color balance using a tone
curve (a revisable graph plotting the input and output
brightness data).

Selects the channel to adjust.

Click on a point to
alter the tone curve.

Use this to
repeat the
same
adjustment.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○
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• You can delete a point on the curve by selecting it and pressing
the [DEL] key.



Table of
Contents

Chapter 1
What is

ZoomBrowser EX?

Chapter 2
Downloading and

Printing Images

Chapter 3
What You Can Do with
a Camera Connected

Chapter 4
Viewing Images

Chapter 5
Organizing Images

Chapter 6
Using Supplementary

Features
Appendices Index

ZoomBrowser EX Software User Guide 103 Back Next

Editing Images (7/10)

Adjusting Sharpness

Use this to emphasize and clarify the outlines of people and
objects.

1. Click  (Edit) in the Viewer Window and select
[Sharpness].
The Sharpness window will open.

2. Select the [Sharpen] or [Unsharp Mask] tab, adjust the
settings in the respective windows and click [OK].

Sets the magnitude of the effect.

Sets the magnitude of the effect, its radius (the
area over which it will search for contours) and
threshold (basic value determined to be a contour).

■ Sharpness Window

■ Unsharp Mask Window
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Editing Images (8/10)

Trim

Use this to delete unnecessary portions of the image and leave
only the necessary portions.

1. Click  (Edit) in the Viewer Window and select [Trim]
to open the Trim Image window.

2. Position the mouse pointer over the image and drag
it to select the trimming area.

3. Click [Trim Image]
The specified area is trimmed.

4. Check the trimmed image and click [OK].
This completes the trimming procedure.

You can change the display magnification.

Drag to specify the
trimming area.

You can also specify the
trimming area with numbers.

Use this to reset the
specified area.

You can adjust the trimming area by dragging
the corners or center points of the sides.
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Editing Images (9/10)

Insert Text

Use this to place text on the image.

1. Click  (Edit) in the Viewer Window and select
[Insert Text].
The Insert Text window will open.

2. Move the mouse cursor over the image and click
where you would like to place the text.

Click [Undo All] to restore the image to its pre-adjustment state.
Click [Undo] to cancel the action immediately preceding.
Click [Redo] to reinstate an action canceled with the Undo button.

Dragging (or clicking) on the window
displays a text frame. Next, input the
text into the box at the right.

You can change the display
magnification and display area.

3. Input text and set the font type, size and other
attributes.

4. Click [OK].
This completes the text input process.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can move the text frame by dragging it.
• You can change the text frame size by dragging the corners or

mid-points on the sides.

Sets the font, font size, text
color and text attributes.

Place a check mark here to have the
text edges blend into the image.

Inserts comments attached to the
image or the shooting date/time.
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Editing Images (10/10)
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• You can use the following tools when editing.

Zoom In/Zoom Out Button
Zooms in or out (makes a portion of the image appear
larger or smaller). The Navigator window appears when
the image is zoomed in.

Pan Button
(Only available when the image is zoomed in)
Clicking and dragging changes the position of the
zoomed-in area of the image.

Fit to Window Button
Sets the image display size to the window size.

Display Size
Changes the image display magnification.

• Restores the window to an editable state for red eye correction,
trimming and inserting text when the [Zoom In], [Zoom Out] or
[Pan] buttons have been used.

Red Eye Correction Button (Only available in
manual red eye correction mode)
Click the red area to correct it.

Trim Button (Only available when trimming)
Drag the cursor to set the trim (crop) area.

Text Button (Only available when inserting text)
Drag (or click) to select the insertion point.

Saving under a Different Name

You can leave the original image file untouched and save the
edited image in a new file under a different name. After editing
the original, click the [File] menu in the Viewer Window and
select [Save As] to open the Save dialog. Set the file name,
format and image quality and click [Save].

Overwriting the Image

To overwrite the original image file with the edited image data,
use the Save dialog from the Saving under a Different Name
procedure and save the file leaving the file name the same as
the original. (The original file name is displayed in the Viewer
Window.)
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Editing Images with Other Programs
This section explains how to start other image editing programs to edit
an image selected in ZoomBrowser EX.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○
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• To register other image editing programs, click  (Edit) in the
Viewer Window, and select the [Edit Image with External Tool]
submenu, followed by [Manage List].

How to start other image editing programs

1. Click  (Edit) in the Viewer Window, select [Edit with
External Image Editor] and select an editing program
from the submenu.

The image editing program will start and open the selected
image in it.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can also start up other image editing programs by selecting
[Edit] followed by [Edit Image] in the Task Area of the Main
Window.
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This section explains how you can send images in e-mail.

Sending Images by E-mail (1/2)
3. Click [2. Change Image Size] and set the image size

and quality.
○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• To use this function, your e-mail program must be set up as a
MAPI client. For detailed information on how to set up your e-
mail program, refer to the documentation that comes with it.

How to send an image by e-mail

1. Click [Internet] in the Main Window, followed by
[Email Images].

2. Confirm that [1. Select Images] is selected, and select
the images in the Browser Area.
You can select multiple images or a folder and have the images
in the folder included in the e-mail attachment.
RAW images cannot be attached.

Use this option if you want to
reduce the size of the image.

Use this option if you do not want
to change the size of the image.

Use it to check the file size
when you actually compress
the image. (The file is
displayed in the “Total size of
changed images” category.)

Specify the image quality.
(The lower the quality, the
rougher the image
becomes, but the size of the
file also becomes smaller.)

Select the long or short side and set
the image size in numbers.

Use it to check the image quality as it will appear
when compressed. (A preview image will display.)
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4. Click [3. Send or Save] and select whether to create a
new e-mail or save the image.

5. Click [4. Finish].
• If You Selected [Create a new email]:

Your e-mail program will start and the selected images will
appear as an attachment in the message window. Input the
address, subject and your comments and send the message.

• If You Selected [Save the images in a folder to send through
an email program that does not support MAPI.]:
The images will be saved to the specified destination. To send
the images by e-mail, start your e-mail program and attach
the saved image files to a message.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• Some e-mail programs might not be able to start automatically
(those without MAPI support). In this case, save the image to the
disk, start the e-mail program and attach the image to an e-mail
message.

Sending Images by E-mail (2/2)

Save the image
on the disk first.

Start the e-mail program and send
the e-mail immediately.

If you selected [Save the images in a
folder to send through an email
program that does not support MAPI.],
click [Browse] to specify a destination.
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This section explains how to change the size, resolution or data type of
a selected image and write it to a new file, and to export an image for
use as a screen saver or wallpaper. It also describes how to export the
shooting information to a text file.

Exporting Images (1/4)

■ Export Still Images
You can change the data type and/or image size and save it to
a new file. Select one of three data types: JPEG, TIFF or
Windows Bitmap (BMP). You can also add identifying
characters to the start of the file name.

Export Formats

The following types of image export formats are available.

■ Export Movies
You can change the movie size or type and export it as a
different movie file. See "Exporting Movies" for an explanation
of the procedures.

■ Extract Frames from a Movie
This feature extracts still images from movies and saves them as
image files (Windows XP only). See “Extracting Frames from a
Movie” for more detailed instructions.

■ Export Shooting Properties
You can select specific items from the shooting information and
export it to a text file.

■ Export Images as a Screen Saver
You can export an image as a screen saver file.

■ Export an Image as a Wallpaper
You can export an image as a wallpaper file. This function will
not work with multiple files selected.

■ Backing Up to a CD
This feature copies and saves images to CD-R/RW disks. See
“Saving Images to CD-R/RW Disks” for more detailed
instructions. (Windows XP only)

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• The shooting information is saved along with the image when
you save an image as a JPEG in the Export window.
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Exporting Images

1. Click [Export] in the Main Window and select the
export format in the next menu.

2. Confirm that [1. Select Images] is selected, and select
the images in the Browser Area.
You can select multiple images or a folder and have the images
in the folder included.

3. Click [2. Specify Export Settings] and set the export
settings.
The settings content varies according to the export format. The
following page explains the features and procedures for each
window.

Be sure, however, to note the file name and destination when
exporting so that you do not lose track of the exported file.

4. Click [3. Finish].
This will export the image(s).

Exporting Images (2/4)

Export Still Images

Click [3. Finish] after specifying the settings.

Changes the
image size.

Changes the
image type.

Adds a prefix to
the file name.

Destination Folder

Changes the
destination folder.

Calculates the post-
conversion file size.
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Export Shooting Properties

Click [3. Finish] after specifying the settings.

Exporting Images (3/4)

Place check marks beside the
export categories you want.

You can insert or remove
all check marks at once.

Changes the destination folder
(you can also specify a file name).

Destination Folder

Export as a Screen Saver

Click [3. Finish] after specifying the settings.

Place a check mark here to imbed
the selected image as a new screen
saver file (select an image size in
the category immediately below).

Calculates the post-conversion file size.

You can preview the
post-conversion image.

Changes the destination folder
(you can also specify a file name).

Place a check mark here to make
it the default screen saver.
(Windows XP, Windows 2000
only)

Destination Folder
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Export as a Wallpaper

Click [3. Finish] after specifying the settings.

Exporting Images (4/4)

Selects a display method
for the wallpaper.

Select whether to save it to the folder
used by Windows for wallpaper or
another destination.

Changes the destination folder
(you can also specify a file name).

Destination Folder
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This section explains how to run a slide show displaying images in
sequence in the full-screen mode.

Running a Slide Show (1/2)

Setting and Starting a Slide Show

1. Click [View & Classify] in the Main Window, followed
by [View as a Slide Show].

2. Confirm that [1. Select Images] is selected, and select
the images in the Browser Area.
You can select multiple images or a folder and have the images
in the folder included.
The images will display in the order they are selected here.

3. Click [2. Setup Slide Show] and set the display method
for the slide show.

Selects whether to display the slide show
continuously (left button) or quit after
displaying it once (right button).

Select the Image Size option to be used when displaying the images.

Selects the display methods for image information, such as the file
name and titles, and the control panel (explained on the next page).

Select the transition effect to be used when moving from one slide to another
(When you click an effect, you can get a preview of how the effect looks)
If you want the transition effects to be randomly assigned, select [?].

Select [On clicking the left mouse button] to have the slides
proceed manually, not automatically.
Select [Every X second(s)] to have the slides advance
automatically and set an interval in seconds with the slider.
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Running a Slide Show (2/2)
4. Click [3. Start Slide Show].

The slide show starts.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• To view all images in a folder in a slide show, it is convenient to
select [Select All] from the Display Control Panel menu (  ).

• You can also start a slide show by clicking the  (Slide Show)
function button.

Slide Show Control Panel

While running a slide show, you can use the control buttons at
the bottom right of the window to control the show.

The file name and control panel will display if the [Show
information] option was selected in the [Image Information]
section shown in the settings on the previous page.

From left to right, the Back button,
Pause button and Next button.

Click here to end
the slide show.

Print Settings Button
You can select an image to print.
After the slide show ends, the image for
which this button was clicked displays in the
print window.

Select Images Button
You can select images.
After the slide show ends, the image for which
this button was clicked appears in the selected
state in the Browser Area.

Star Rating Settings Button
You can set the Star Rating for an image
while it is displayed.
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You can add sounds to your images and play them later as necessary.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• Sound files attached to images must be of the WAVE type (file
name extension is ".wav") or of the MIDI type (".mid" or
".midi").

• Sound files recorded with the camera's Sound Recorder feature
are also attached to the image.

Adding Sounds to Images

3. Click [Add].
The file dialog box will appear.

4. Select a sound file and click [Open].

5. Click [OK].
Sound is added to the image.
A symbol similar to the one on
the right displays on images
with sounds attached.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• To remove a sound from an image, select the image, click the
[Edit] menu and select [Add/Remove Sound], then click
[Remove]. Finish by clicking [OK] to have the sound removed.

• When you add a sound to an image, the sound file is copied to
the same folder as the image.

This mark indicates an image with a sound.

How to add a sound to an image

1. Select an image in the Browser Area.

2. Click the [Edit] menu and select [Add/Remove Sound].
The following dialog box appears.

How to play a sound added to an image

Select an image with a sound attachment, click the [Edit] menu
and select [Play Sound].

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can also play sounds by clicking the [Play Sound] button
that appears in the information display panel when the display
mode is set to Preview or that appears in the Properties window.
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Two Printing Methods

You can select between the following two methods for printing
images.

■ One Photo per Page Print
This method prints one image
per page. You can use it to print
images like photos with ease. If
you select more than one image,
the corresponding number of
pages are printed.

This method is explained in “Printing a Single Image on a Single
Page” in Chapter 2.

Printing Images

This method is explained on the next page in “Index Print.”

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can select the program to use for printing by clicking [Print]
in the Main Window and selecting [Print Using Other Software].

■ Index Print
This method prints a selection of multiple images in columns
and rows in an index format.
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Index Print (1/2)
1. Click [Print] in the Main Window, followed by [Index

Print].
2. Confirm that [1. Select Images] is chosen and select

images for printing.
The background of the selected images changes to blue.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can select multiple images by pressing and holding the [Ctrl]
key while you click on successive images. To deselect an image,
hold down the [Ctrl] key and click the image again.
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Index Print (2/2)
3. Click [2. Printer and Layout Settings] and set the

categories as desired.
4. Click [3. Print].

Printing will start.

Rotates images.

Sets the printer and
paper size settings.

Sets the number
of print copies.

Sets the number of
rows and columns.

Sets the print settings for
shooting information,
comments, headers,
footers and page numbers.

Click this to use the
trimming function (crops
a portion of the image).

The functions in this
section can be used after
any one of the images
displayed below is selected.

Click this button to switch
between pages if the printout
is more than one page long.
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Using My Camera Maker (Windows XP and Windows 2000 only) (1/3)
The following section introduces the [My Camera Sound Maker] function,
which allows you to record and edit the start-up sound, shutter sound,
operation sound and self-timer sound.

The My Camera window will open.

2. Click the [Set individually] tab, followed by [Create
My Camera Data].
The My Camera Maker window will open.

Starting My Camera Maker

1. Click the [Edit] menu in the Main Window and select
[Manage My Camera].

Creating a Start-Up Image

1. Select the [Start-Up Image] tab in the
My Camera Maker window.

2. Click [Open] and open the image file
that will become the start-up image.

3. Select the desired area of the image and click [Cut].
This will create the start-up image.

Drag the corners or sides of
the frame to set the area.
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Using My Camera Maker (Windows XP and Windows 2000 only) (2/3)

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• The “Sound time” will display in red if the sound file exceeds
the time limit.
If this happens, select the desired sound portion using the
blue and red switches and select [Cuts both switches, before
blue and after red] from the [cut] menu to delete unnecessary
sound portions.
In addition, when you select [Limits blue and red switch to
within limit time], the switches can no longer be moved
outside of the time limit width.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• The Volume switch setting affects the volume of the sound file
to be saved. In other words, if you turn down the volume of a
sound you recorded on the computer because it is too loud
when you play it, the sound will have a low volume when you
upload it to the camera. So when the playback volume is too
loud on the computer, turn down the volume of the speakers.

Click here to record sounds.

Click here to open sound files.

Change the file type.

Ends the recording.

Cuts out unnecessary sound portions.

Use these tabs to switch between sound files for recording and editing.

Volume

Sets the blue and
red switches.

Plays sounds.

The blue and red switches designate the sound
range. (You can delete useless sections by
clicking the [Cut] button after having selected
the desired sound portion with the switches.)

Shows from where the
sound starts to play.

Creating a My Camera Sound

1. Select any tab in the My Camera Maker window from
[2. StartSound] to [5. SelftimerSound].

2. Create and edit sounds using the buttons in the
window shown to the right.
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Using My Camera Maker (Windows XP and Windows 2000 only) (3/3)

Saving Data ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• The actual file name is composed of the name of your choice in
the first part, followed by characters specifying the image or
sound type (_OP01 or _SS01) and the extension (.JPG or .WAV)
in the latter part.

• When a number of different types of sounds are saved at the
same time, the first part of their file name will be the same.

Click here to save a sound (A window allowing you to name the file will display).

Select the sound to be saved.

Switch to the Save window in the [6. Save] tab.
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Sound files recorded with the camera's Sound Recorder feature can be
downloaded like regular image files to the computer. The sound file
symbol will appear on the thumbnails in the Browser Area.

Playing Sound Files

Sound File Symbol

Double-clicking a thumbnail causes the Viewer Window to
display and play the sound.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can also replay a sound file by selecting it in the Main
Window, clicking the [Edit] menu and selecting [Play Sound]. In
addition, you can replay a sound file by clicking the [Play Sound]
button that appears in the information display panel when the
display mode is set to Preview and that appears in the Properties
window.
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ZoomBrowser EX supports movies.

You can download movie files and display them in the Browser
Area just like ordinary images. The movie thumbnail and movie
icon will show in the Browser Area. (Only the movie icon
appears for QuickTime movies.)

Playing Movies
Double-clicking a thumbnail causes the Viewer Window to
display and play the movie.

Movie Icon

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• The QuickTime program is required to play movies on the
Windows 2000, Windows Me and Windows 98 SE operating
systems. See the Software Starter Guide and install
QuickTime.

You can save the displayed scene
as a still image. (Windows XP only)

You can play movies and
advance or rewind frames.

You can control the sound
volume.
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You can edit movies by adding various effects: linking movies and still
images that have been downloaded to a computer, superimposing titles
and other text, and adding background music.

Editing Movies (1/4)
Follow these steps to proceed.

Guidance

Click this button for detailed
help with operating procedures.

Storyboard Area
Displays thumbnails of the selected images.
Links images in order from left to right.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• If you are using Windows 2000, Windows Me or Windows 98
SE, the QuickTime program is required to edit movies. See the
Software Starter Guide and install QuickTime.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• Movies are saved as Motion JPEGs (AVI).

Procedures for Editing Movies

1. Click [Edit] in the Main Window, followed by [Edit
Movie].

2. Confirm that [1. Add Images] is selected, and select
the images (movies or stills) in the Browser Area.
You can select multiple movies or still images.

3. Follow steps 2 to 5 at the left of the window and click
[6. Exit] when you finish editing the movie.
The features and procedures for each step are explained on the
following pages.
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Features of the Storyboard Area

Editing Movies (2/4)

Transition Box
Displays the icon of the transition
effect used to link adjacent images.

Displays a dialog with the
general movie editing settings.

Changes the order of the
selected images.

Displays the properties of the selected image.

Deletes the selected image from the storyboard area.

Click this button to play
the movie being edited.
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Features of the [2. Arrange] Window Features of the [3. Apply Effect] Window

Editing Movies (3/4)

Moves the image selected in the storyboard
area one position to the left or right.

You can set the playback range (start and stop points)
of a movie selected in the storyboard area by clicking
this button.
You can set the play duration of a still image selected
in the storyboard area by clicking this button.

Superimposes titles and other text on the image
selected in the storyboard area.
You can set the font, display duration, display
position and scrolling attributes of the text.

You can set the transition effect between
images by selecting the transition effect box in
the storyboard area and clicking this button.

You can change the image selected
in the storyboard area into a sepia
or monochrome image.

You can rotate or flip the selected image. Magnifies a portion of
the selected image.
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Features of the [5. Save] Window

Editing Movies (4/4)

You can link MP3 and WAV audio files as background music or sound effects.
When you link a sound file using this procedure, a bar appears under the
thumbnail in the storyboard area indicating the duration of the audio file.

Features of the [4. Set Audio] Window

You can adjust the volume or set the fade-in or fade-out effect for a movie or
its linked audio file by selecting it in the storyboard area and clicking this
button.

Specifies the file name.

Selects the destination folder.

Saves the file.

Select this to make advanced settings.
You can set the size (horizontal and vertical pixel counts),
frame rate (frames per second) or audio settings of the movie
as it will be saved by selecting [Motion JPEG (AVI)] in the list
below and clicking [Advanced Settings].

Select this to save it
with standard settings.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• Sound files recorded with the camera's Sound Recorder feature
can also be linked as background music or sound effects.
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Exporting Movies (1/2)
This feature changes a movie to another file type or size and exports it.

Features of the [2. Select the save image type] Window
Procedures for Exporting Movies

1. Click [Export] in the Main Window, followed by [Ex-
port Movies].

2. Confirm that [1. Select Movies] is selected, and select
a movie in the Browser Area.
You can select multiple movies.

3. Follow steps 2-4 at the left of the window to proceed
and click [5. Start export] to finish.
The features and procedures for each step are explained on the
following pages.

Follow these steps
to proceed.

Select the format to save the movie file.

To save the movie in a rotated orientation, click here to add a check mark and
specify a rotation direction.
This feature is handy for rotating and saving movies shot with the camera held
vertically.



Table of
Contents

Chapter 1
What is

ZoomBrowser EX?

Chapter 2
Downloading and

Printing Images

Chapter 3
What You Can Do with
a Camera Connected

Chapter 4
Viewing Images

Chapter 5
Organizing Images

Chapter 6
Using Supplementary

Features
Appendices Index

ZoomBrowser EX Software User Guide 130 Back Next

Exporting Movies (2/2)

Features of the [3. Set the save image type] Window Features of the [4. Specify name of file to be saved]
Window

To save the movie under its original file name, select [Same as original image]
To assign sequential numbers in a multiple movie selection, select [Assign
Sequence No.] and specify a root name to precede the numbers.

Selects the destination folder.

To change the size of the movie being exported, select [Zoom
specification] or [Size specification] and set the size.

Selects the number
of frames displayed
each second.

Sets the image quality. Although
less image degradation occurs
the higher the image quality is
set, the file size becomes larger.

Selects the
audio quality.
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This feature extracts still images from movies and saves them as image
files. It can only be used with the Windows XP operating system.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can also save the specified image as a still from the Viewer
Window.

Extracting Frames from a movie

1. Click [Export] in the Main Window, followed by
[Extract frames from a movie].

Extracting Frames from a Movie (Windows XP only) (1/2)

2. Confirm that [1. Select movie] is chosen and select a
movie in the Browser Area.

3. Click [2. Set extraction method] and select the still
extraction method.

■ Extract All Frames
Extracts all frames in the movie as stills. Please note that the
image numbers and file sizes may be large.

■ Specify an Interval and Extract Frames
Extracts frames as stills from a specified frame range or time
interval.

■ Specify the Number of Copies and Extract Frames
Extracts a specified number of stills from the entire movie. The
extraction interval is calculated based on an equal distribution
of the specified number of stills.

■ Extract a Specified Image
Extracts stills from scenes that catch your attention.
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Extracting Frames from a Movie (Windows XP only) (2/2)
4. Click [3. Preview image] and check the extracted stills.

If you selected [Extract a specified image] in the previous
window, the movie will display in the upper part of the
window. Display the images you want and click the [Add]
button. (You can add as many stills as you wish.)

5. Click [4. Set up save] and specify a destination and file
name.

6. Click [5. Perform processing].
Stills will begin to be extracted.

Sets the file name. Sets the destination folder.

Sets the folder name for auto play.

Rotates images (all).

Clears or adds check marks
from or to all at once.

Changes the
thumbnail size.

Clears check marks from all the
preceding or subsequent images.

Saves images with
check marks only.

You can set the volume and play the movie at
normal speed, half speed or double speed.
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Converting RAW Images (1/6)
If your camera supports RAW images you can handle higher quality
images.
However, since they are a special type of image, they cannot be opened
by many image editing programs. It is first necessary to convert them
into standard image files.
This section explains conversion procedures.

Converting RAW Images

1. Select a RAW image in the Browser Area.

2. Click [Edit] in the Main Window, followed by [Process
RAW Images].
When the window showing the procedures for converting and
adjusting RAW images appears, click [OK].

As shown on the next page, the Main Window, Navigator
window, and Image Quality Adjustment Window will display.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• See the user guides for your camera to check whether your
camera supports RAW images or not.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• RAW images are extremely high-quality images that are not
subject to any deterioration due to compression processing.

• See the Help file for conversion details. You can open the Help
file after clicking [Process RAW Images] in Step 2 by clicking the
[Help] menu in the Main Window that opens.
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■ Main Window
The conversion is conducted in this window.

■ Navigator Window

■ Image Quality Adjustment
Window
You can adjust the brightness,
contrast and coloration of a
RAW image as it is converted.
See the Features of the Image
Quality Adjustment Window
for details.

Converting RAW Images (2/6)

Thumbnail

Check Mark

Preview

You can use this button to switch between
images and set various conversion settings,
such as the image rotation.

You can change the area of
the preview image displayed
when it is zoomed in the
Main Window by dragging
these red symbols.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• If the Navigator is not displayed, you can click the [View] menu
in the Main Window and select [Show Navigator] or click the

 in the window’s upper right.
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3. Adjust the image quality as required in the Image
Quality Adjustment Window.

4. Click the [Save] button in the Main Window, set the
image type and save destination, and then click
[Save].

Converting RAW Images (3/6)

Selects images that will be saved
with the same settings.

Selects the image type,
compression ratio and resolution.

Sets the destination
folder for the image file.

You can change the image file
name.
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Converting RAW Images (4/6)

Features of the Image Quality Adjustment Window

The adjustable categories vary according to your camera model.

Adjusts the white balance
by the light source or
color temperature, etc.

Adjusts the photo effect,
contrast, sharpness and
saturation.

With a check mark here,
settings changes in this
window are immediately
reflected in the image.

Selects preset color schemes or
My Color custom color schemes
(see next page for explanation).

When there is no check mark in the
Preview box, this button will
display the image that reflects the
selected settings.

Restores all adjustments to the initial shooting settings.

You can adjust the RGB channel
settings together or individually.

You can set the color space for the output.

Adjusts the digital
exposure compensation.
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Converting RAW Images (5/6)

Registering Custom Color Schemes (My Color)

If you register a custom color scheme as a “My Color” scheme,
you can apply this scheme to additional images when you
convert RAW images.

2. When the Create My Color window displays, click
[Next].

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• To register a “My Color” scheme, two images are required:
the pre-adjustment image and the post-adjustment image.
Use ZoomBrowser EX’s image editing functions to prepare the
two images before proceeding. Save the two images as BMP,
TIFF or JPEG images.

• My Color schemes cannot be used with some camera models.

1. Click the [Edit] menu, select [My Colors] and select
[Create and Add My Color] from the next menu.

3. Click [Select] beside the original image, select the pre-
adjustment image (original image) and click [Next].
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Converting RAW Images (6/6)
4. Click [Select] beside the target image, select the post-

adjustment image (target image) that you have modi-
fied with an image editing program, and click [Create].

5. Check the Preview My Color Applied to the Image and
click [Next].

6. Type a name or comment and click [Finish].

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can apply the registered My Color scheme to additional
RAW images when you convert them by selecting it from the
Photo Effect menu in the Image Quality Adjustment Window.

The program will calculate the differences between the original
and target images, apply those corrections to the original image
and display the results as the Preview My Color Applied to the
Image.

Other Features

You can also use the following features in the Main Window.

You can open converted images
in other application programs.

Displays
histograms.

Displays shooting
information.
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If you have several images of the same scene with only slight
differences, you can use PhotoStitch to connect the images together to
make a panoramic image. This section explains how to use this program
to stitch images.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• For detailed information on how to use PhotoStitch, refer to
PhotoStitch Help (accessible from the [Help] menu).

• You can make it easier to stitch images together by using the
camera’s Stitch Assist mode to shoot them.

Stitching Panoramic Images - PhotoStitch
Then, follow the instructions on the upper part of the
PhotoStitch window, and stitch your images together.

Opening PhotoStitch

1. Click [Edit] in the Main Window, followed by [Stitch
Photos].

2. Confirm that [1. Select Images] is selected, and select
the series of images in the Browser Area.

3. Click [2. Open PhotoStitch].

Perform stitching.

Decide the order
in which the
images should be
stitched.

Save the image.
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Saving Images to CD-R/RW Disks (Windows XP Only)
You can copy or save images onto CD-R disks and CD-RW disks. The
shooting information is saved along with the image. 4. Confirm that [1. Select Images] is selected, and select

the folder or image in the Browser Area.

5. Click [2. Specify Backup Settings], select the
destination CD-R/RW drive and input a CD title.

3. Click [Export] in the ZoomBrowser EX Main Window,
followed by [Backup to CD].

6. Click [3. Start Backup].
This will copy the images to the CD-R/RW disk.
The disk will be ejected from the drive when copying is complete.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• This feature is only possible with computers satisfying the
following conditions.
- Windows XP is pre-installed
- A CD-R/RW drive is built-in

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• You can add additional images to a CD-R/RW disk that has been
written to previously.

Destination Drive

CD Title

Available
Space on the
CD-R/RW Disk

Speed

1. Place a CD-R/RW disk in the
drive.

2. If a window like the one
shown here appears, click
[Cancel] and close the win-
dow.
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The following is a list of image types supported by ZoomBrowser EX. ■ Video clip (.AVI)
Standard Windows movie image type. The movie thumbnail
and a movie icon show in ZoomBrowser EX’s Browser Area.

■ QuickTime (.MOV)
This is a movie which display as a movie mark in the Browsing
Area of ZoomBrowser EX.

■ MPEG4 (.ASF)
Movies that integrate multimedia data, such as video, audio
and text. Primarily used by Windows programs. The MPEG4
compression technology allows for compact file sizes and
delivery over networks.

Supported Image Types

Readable data types

ZoomBrowser EX can read the following image types.

■ JPEG (.JPG)
Most cameras use this image type. It compresses at very high
ratios, taking advantage of the characteristics of the human
eye. However, because it is an irreversible compression method
(part of the data is lost during compression), if you process and
save an image repeatedly using this method, the image may
become rougher.

■ RAW (.CRW/.CR2)
This is a proprietary image type provided by Canon. It saves the
output of the image pixels from a digital camera without any
deterioration in the quality of the image. Some cameras might
not support this image type.

■ Windows bitmap (.BMP)
This file type comes standard with Windows. Most Windows
programs support it.

■ TIFF (.TIF)
This is a relatively popular image type. It is widely supported by
non-Windows programs (such as Macintosh).

■ PhotoCD (.PCD)
This is the image type used by Photo CDs.
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ZoomBrowser EX provides preference settings that you can customize.
This section introduces the preference settings you can change.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• ZoomBrowser EX offers a wide variety of preference settings that
you can customize. Therefore, before you modify an option,
access Help from the [Help] menu or  [Help] button to see a
description of the option.

Customizing Preferences (1/4)

General Tab

This tab sets the way the tiny version of the images (thumbnail)
is handled in the Browser Area, and sets the zoom behavior.

Opening the Preferences dialog box

Click the [Tools] menu and select [Preferences] to open the
Preferences dialog. To change a setting, click the appropriate
tab in this window.

Sets the thumbnail settings
for the Browsing Area.

This group box controls the
way the zoom operations
react in the Browsing Area
(Moving the slider to the
right increases the image
display speed).

Place a check mark here to open a confirmation
message for filtering the images that are displayed.

Place a check mark here to display
tips when ZoomBrowser EX starts up.

Sets the depth of folder
(level in the hierarchy)
that will display in the
Scroll mode. The default
setting is 0.

Place a check mark here to adjust the
image colors to the monitor's color profile.
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Selection Tab

This tab sets the image selection methods and the image
selection steps used with the task buttons.

Customizing Preferences (2/4)

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• If Toggle Selection is selected, clicking an image selects it. To
deselect it, click it again. You can select multiple images by
clicking on more images in succession.

Rotation Tab

ZoomBrowser EX displays images or movies rotated to match
the camera display orientation. However, it does not alter the
image or movie data itself. If a rotated image or movie is
opened in a program that does not support rotated display, it
will appear in its pre-rotation state on its side.
You can have the image data rotated to the vertical orientation
when it is downloaded from the camera by changing this
[Rotation] setting. You can rotate and save movies using the
[Export] task.

Sets the image
selection method.

Place a check mark here to always require the image selection step when
performing a procedure with the task buttons. (If the check mark is cleared, the
image selection step is eliminated when an image is already selected in the
Browser Area.)

Place a check mark here to have
the image data rotated to the
vertical orientation during the
downloading of images recorded
in the vertical orientation.

Sets whether to Show/Hide the
message that displays after a
movie shot in the vertical
orientation is played.



Table of
Contents

Chapter 1
What is

ZoomBrowser EX?

Chapter 2
Downloading and

Printing Images

Chapter 3
What You Can Do with
a Camera Connected

Chapter 4
Viewing Images

Chapter 5
Organizing Images

Chapter 6
Using Supplementary

Features
Appendices Index

ZoomBrowser EX Software User Guide 144 Back Next

Customizing Preferences (3/4)

Printing Tab

Sets the printing preferences.

Shooting Information Tab

Sets the preferences for image information.

If the Easy-PhotoPrint program accompanying a Canon-brand
printer is installed, you can select whether to use Easy-PhotoPrint
or the ZoomBrowser EX printing function when the [One Photo
Per Page] task is selected.

Place check marks beside the
categories to be displayed as image
information.

You can select/deselect all at once
and restore the default settings.

Place a check mark here to
display the information content
without the category name.

Sets the font type and size for the
text in the information displayed
in the preview window.
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Customizing Preferences (4/4)

Themes Tab

Sets the color theme (background colors and selection colors,
etc.) for the entire ZoomBrowser EX program.

Selects a color theme.
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Sets whether options are shown or hidden on the menus opened by
clicking task buttons in the Main Window.

Click the [Tools] menu and select [Customize] to open a
window like the one shown below.
Use this window to set the categories to display and click [OK].

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

REFERENCE

• Use this function to hide items not used on a daily basis to
streamline the menus or to shorten the menus so that scrolling
is not required.

Customizing Menus

Sets the categories displayed in this menu.

Remove the check mark from the menu items you wish to hide.
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This section explains solutions to software problems. See the user
guides for your camera for solutions to camera or wireless connection
problems.

Troubleshooting (1/5)

Camera Not Detected or Recognized

• A message such as “No camera was found” displays when you
attempt to download images from the camera.

• Even though [Canon CameraWindow] is selected in the Events
dialog, the Camera Control Window fails to open when the
camera and computer are connected with the interface cable
and set to the correct communication mode.

In either case, confirm the status of each of the following items
in order.

The Events dialog box does not appear

The dialog below fails to appear even though the camera is
correctly connected to the computer via the interface cable and
ready to transfer data.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

IMPORTANT

• With some versions of Windows, this dialog may not appear
the very first time the camera is connected to the computer
after it is booted up. (It will display subsequently.)
In that case, click the [Start] menu and select [Programs] or [All
Programs], followed by [Canon Utilities], [CameraWindow],
[PowerShot - IXY - IXUS - DV 6] and [CameraWindow].

■ Check your Computer
Ensure that your computer meets the following requirements.
ZoomBrowser EX will not operate on computers failing to meet
these requirements.
• Built-in USB ports on a computer pre-installed with Windows XP

(including Service Pack 1, Service Pack 2)/Windows 2000 Service
Pack 4 only/Windows Me/Windows 98 SE only.

■ Check the Connection between the Camera and Computer
Confirm that the camera is correctly attached to the computer
with an interface cable. See the user guides for your camera for
connection information.
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Troubleshooting (2/5)
■ Check the Camera Status

Confirm that the camera is on and in the correct mode to
transfer data. Please see the user guides for your camera since
the methods for setting the camera and computer to the
communication mode vary between camera models. (With
some models, you must set the camera to the Playback mode,
etcetera, to establish a connection to a computer.)

■ Check the battery
You are recommended to use a household power source (AC
adapter) for the camera when connecting it to the computer. If
the camera is running on batteries, ensure they are fully
charged.

If the problem does not rest in the four areas above, the driver
may not be properly installed. Uninstall the driver and then
reinstall it. For instructions for this task, refer to the Software
Starter Guide.

How to Get Help

ZoomBrowser EX comes with a Help file. Use it when you want
to learn how to do an operation, or when you want to know
about the features of the program.
You can access Help from the [Help] menu or the [?] (Help)
button.

Help Menu

Help Button



Table of
Contents

Chapter 1
What is

ZoomBrowser EX?

Chapter 2
Downloading and

Printing Images

Chapter 3
What You Can Do with
a Camera Connected

Chapter 4
Viewing Images

Chapter 5
Organizing Images

Chapter 6
Using Supplementary

Features
Appendices Index

ZoomBrowser EX Software User Guide 149 Back Next

Troubleshooting (3/5)
3. Double-click the [dbconverter.exe] or [dbconverter]

file in that folder.

4. Select the database file that was used with the
previous version of the program and click [Start].
For example, select the following database file if it was used
previously: [C: \Program Files\Canon\ZoomBrowser
EX\Database\My Database.zbd].

If You Were Using ZoomBrowser EX Version 2 or 3

■ Images Were Assigned Titles or Comments
Use the following procedures to display titles and comments
previously input in ZoomBrowser EX Ver. 2/3.

1. Start Windows Explorer by clicking the [Start] menu
and selecting [All Programs], followed by [Accessories]
and [Windows Explorer].
(With Windows 2000/Windows Me/Windows 98 SE, right-click
the [My Computer] icon and select [Explore] from the popup
menu.)

2. Open the [Program] folder
inside the folder into which
ZoomBrowser EX 5 was
installed.
For example, open the folder to the
right if the following path is correct:
[C:\Program Files\Canon\ZoomBrowser
EX\Program].
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Troubleshooting (4/5)
5. Click [OK] if the following dialog appears.

6. Click [Close] when the dialog in Step 4 appears.
This will display in ZoomBrowser EX 5 the titles and comments
input in version 2 or 3. The titles and comments will appear
together in the Comments section of ZoomBrowser EX 5.

■ Image Files Were Saved Below the Program Files Folder
in a Previous Version
In ZoomBrowser EX 5, image files in folders within the Program
Files folder will not display. To display these images, perform the
procedures below after you have followed steps 1-6 on the
previous page.

1. Use Windows Explorer to copy the image folders
within the Program Files folder and paste them in
another folder higher in the directory hierarchy.
For example, if a folder called the [Image Library One] folder is
in the Program Files folder, move it to a higher location, such as
the [C:\] drive.

Titles and comments input
in ZoomBrowser EX 2/3.

Titles and comments as they appear
in ZoomBrowser EX 5.
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IMPORTANT

• Do not copy just the images from within the folder, copy the
folder itself to a location higher in the directory hierarchy.

Troubleshooting (5/5)

When you select the copied folder in ZoomBrowser EX 5, the
images will now display.

Click the copied folder to display its images in the Browsing Area.
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Index (1/2)
A Adjusting Sharpness  103

All Folders  55
Auto Adjustment  97, 99
Auto Download Settings  24, 26
Auto Start  13
Autofocus Frame

Displaying  72

B Brightness  100
Browser Area  6, 7, 55

C Camera Browser Window  29, 31, 32, 35, 39
Camera Control Window  6, 13, 17, 22
Camera Settings  48
CD-R/RW Disks

Saving Images  140
Changing the Display Magnification

Main Window  66
Viewer Window  70

Changing the Display Mode  57, 63, 64
Changing the Displayed Folder  60
Classifying Images  80
Color Management  142
Color Profile (Monitor)  142
Color/Brightness Adjustment  97, 100
Comment  92, 93
Contrast  100
Copying Images  86

to the Camera  49

Creating Folders  95
Creating My Camera Settings Files  46
Custom Color Schemes (My Color)  137
Customizing Menus  146

D Deleting Images  89
From the Camera  31

Deselecting All Images  75
Destination for Downloaded Images  30
Destination for Downloaded Sounds  34
Direct Transfer Menu  24
Display Control Panel  10
Display Modes  10, 57
Displaying Multiple Images  71
Download Mark  16, 18
Downloading Images  12

Camera Operations  24, 25
Checking Images before Downloading  29
Computer Operations  26

Downloading Sound Files  32

E Easy-PhotoPrint  20, 144
Edit with External Image Editor  97, 107
Editing Images  97
Editing Movies  125
Events Dialog  147
Exporting Images  110, 111
Exporting Movies  129
Extracting Frames from a Movie  73, 131

F Favorite Folders  55
Deregistering  56
Registering  56

Filter Tool  63
Folder Area  6, 55
Folder Depth (level in hierarchy)  58
Full Screen Display  70
Function Buttons  10

H Help  148
Hiding the Folder Area  67
Hiding the Task Area  67
Higher Level in the Folder Hierarchy  61
Histogram  92, 93, 101

I Image Information  72
Image Properties  92, 93, 94
Index Print  118
Information Panel  59
Insert Text  97, 105
Interval Timer Shooting  53

J JPEG  141

K Keywords  78, 92, 93

L Last Acquired Images  16, 18, 55
Level Adjustment  101
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Index (2/2)
M Main Window  6, 16

Monitor's Color Profile  142
Moving Images  85
MPEG4  141
My Camera Maker  45, 120
My Camera Settings  40, 41
My Camera Window  41
My Color (Custom Color Schemes)  137

N Navigator Window  66, 70
New Folder  95

O Opening Images  69
Owner's Name  48

P PhotoCD  141
PhotoStitch  139
Playing Movies  73, 124
Playing Sound Files  74, 123
Playing Sounds on Images  116
Pop-Up Window  68
Preferences  142
Preview Mode  59, 93
Printing (via a Computer)  25
Printing a Single Image on a Single Page  20
Printing Images (Camera Browser Window)  35
Printing Images (in the Camera)  36
Printing Images (Main Window)  20, 117, 118
Printing Images (Viewer Window)  74
Properties Window  92

Q QuickTime  124, 141

R RAW  73, 133, 141
Record Sounds  121
Red Eye Correction  97, 98
Refreshing Folders  96
Remote Shooting  51
Renaming Folders  82
Renaming Images  81
RGB (Red, Green, Blue) Intensity  101
Right-Click  7
Rotating Images  91

S Saturation  100
Save As  106
Screen Saver  110, 112
Scroll Mode  58
Searching Images  83
Selecting All Images  75
Selecting Folders  55
Selecting Images  75
Selecting Multiple Images  75
Sending Images by E-mail  108
Sharpness  97, 103
Slide Show  114
Sorting Thumbnails  64
Sound Files (guideline for length of sound)  45
Sound Recorder  32, 74, 123
Sounds on Images  116
Star Rating  76, 92, 93
Stitch Assist Mode  139
Synchronizing Multiple Images  71

T Task Area  6, 8
Task Buttons  8
Theme  41
Thumbnail  57

Display Size  65
Information  64

TIFF  141
Timer Shooting  53
Tone Curve Adjustment  102
Trim  97, 104

U Using the Task Windows  9

V Video clip  141
View Image  69
Viewer Window  70, 97
Viewing Image Properties  92

W Wallpaper  110, 113
WAV  32
Windows bitmap  141

Z Zoom In  66
Zoom Mode  57
Zoom Out  66
ZoomBrowser EX

Closing  19
Starting  12, 19
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Disclaimer
• While every effort has been made to ensure that the information contained in this guide is accurate and complete, no liability

can be accepted for any errors or omissions. Canon reserves the right to change the specifications of the hardware and software
described herein at any time without prior notice.

• No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any language
in any form, by any means, without the prior written permission of Canon.

• Canon makes no warranties for damages resulting from corrupted or lost data due to a mistaken operation or malfunction of
the camera, the software, memory cards, personal computers, peripheral devices, or use of non-Canon memory cards.

Trademark Acknowledgments
• QuickTime is trademark of Apple Computer Inc., registered in the United States and other countries.
• Microsoft and Windows are either registered trademarks or trademarks of Microsoft Corporation in the United States

and/or other countries. Microsoft® Windows® 98, Microsoft® Windows® 2000, Microsoft® Windows® Millennium Edition,
and Microsoft® Windows® XP are referred to in this guide, respectively, as Windows 98, Windows 2000, Windows Me,
and Windows XP, or as Windows.

© 2006 CANON INC.CDA-E009-010
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